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Get Help

Get Help
There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications
Use help icons    to access help in the application. If you don't see any help icons on your page, click your user image
or name in the global header and select Show Help Icons.

Get Support
You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training
Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community
Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Learn About Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in
this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback
We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!
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1  Overview

Overview of Using Student Management  
In Student Management you can support your students' learning experience, manage your student data with
streamlined flows, and meet your tracking and reporting requirements. Use the Academics work area to complete all
these activities.

Here are some things you can do in the Academics work area:

• Manage person details.

• Manage external organizations.

• Design admissions application forms.

• Manage submitted applications.

• Manage curriculum items such as courses and programs.

• Manage student programs, enrollment, and credentials.

• Manage scheduled course and grade rosters.

A scheduled course is also known as a course section.

• Manage fees, discounts, and schedules.

• Manage student accounts.

1
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2  Search Navigation

Use Search Navigation  
Use the Search Navigation feature as the primary navigation through the Student Management application.

Search navigation makes it easy for authenticated users to browse, search, and navigate to destinations they have
access to.

Access search navigation from the banner on your Student Central landing page or from a page in the Student
Management application (availability depends on the type of page).

Select one of the destinations shown in the search modal. Or, type in the search field and select from the search results.
You can see destinations and search results for only the pages that you have access to.

To search for a course, enter the course in the search field and click Search in Course Catalog. You're taken to the
catalog search page and the value you entered is used for the search.

To search for people, enter the name of the person in the search field and then click Search in Person Search. You're
taken to the person search page and the value you entered is used for the search.

To navigate from Student Central to Home, click Search and click the Home link shown in the modal.

To navigate from Home to Student Central, click Navigator > Academics > Person Search.

Academic Settings
The Academic Settings page is available to staff personas and administrators. It provides a list of settings the user has
access to. The list is organized in categories to help users browse and find settings they need for their job functions.

Staff roles must be granted access to the Academic Settings page.

In the search modal, click Academic Settings. To find a page, expand the sections and browse or use the search field.
You can see only the pages that you have access to.
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3  Person

Create Person Profiles  
As an administrator, you can create person profiles for application users.

Here's how you create a person profile as an administrator:

1. From Student Central, click Search and search for Person Profile Search.
2. Click Create Profile.
3. Enter the user information such as name, user name, date of birth, and email ID.
4. Click Register. A search begins, to check whether the user already exists.

◦ If a match is found with the same user name, you can view the matched profile, return to the Create
Profile page, and change the user details to create a different user.

◦ If a match is found with the same name and email ID, you can view the potential duplicate profiles, and
go ahead with creating another user anyway.

After the user is created, you can either view their profile or create another user.

Self-Service
Self-service users, such as students and applicants, can create a person profile for themselves through self-registration.
When they're creating the user account through self-registration, they must specify a unique user name and email ID.

As new users, group owners can create a person profile for themselves. They can create a profile for another user, if one
doesn't already exist, who the group owners can then add to their managed student groups.

Related Topics
• Create Managed Student Groups

Manage Persons  
As an administrator, you can manage information about persons associated with your academic institution. For
example, you can view, add, or update personal information of applicants and students, including name, address,
gender, date of birth, emergency contacts, and so on.

To manage persons, use the Person Profiles work area: From Student Central, click Search and search for Person
Profile Search.

Here's what you can do in Person Profiles:

• Create a person.

• Search for a person.

• View or edit personal information, such as name and contact information.

• View or edit deceased information.

5
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• View or edit national identifiers, such as SSN.

• Assign attribute tags, such as an athlete or a military tag.

• Assign service hold tags, such as a library service hold tag.

• View a summary of academic data related to the person, such as the enrolled academic program.

• View admissions applications of a person.

• Review the tasks and complete a task on behalf of the person.

• View or edit residency information to specify whether student is a resident of the state, province, or country
where your institution is located.

• View managed student group relationship, such as whether the person is a child of another person in a group.

Activating Users
Each person record is identified by a constituent ID. In an academic institution, constituents are persons such as
applicants, students, or faculty members. When you search for a person, the results may show a mix of records with
and without constituent IDs. The ones with constituent IDs are active in Oracle Student Management Cloud Service.
Those with no constituent IDs in the search results aren't active in Student Management but they're active in the other
products, such as Oracle Financials Cloud Service and Oracle Global Human Resources Cloud Service.

In Person Profiles, if a user doesn't have a constituent ID, you can click Activate User to activate the user in Student
Management.

Tasks and Checklists
You can view the individual tasks, as well as checklists with their accompanying tasks, assigned to a student or
applicant. Locate the student using the Person Profiles work area, and then click the To-dos tab. The tab highlights
which tasks are upcoming and need attention; it also keeps the completed task history for the person. You will see all
incomplete or completed tasks assigned to the student, whether individual tasks or part of a checklist. Click any task to
drill down into its details and view its progress. You can also complete tasks or checklists on the person's behalf. If the
task is a document submission task, you can upload the document or download the submitted documents. Upload only
a PDF document with a maximum size of 5 MB.

You can also reassign one or more tasks, if the task was set up to allow reassignment to another person. For the task,
select Actions > Reassign Task. When you find the reassignment recipient, click the Reassign button next to their
name.

Delete Personal Information
You can't delete a person record but you can delete some of the personal information using the Person Profiles work
area. Here are some examples of the personal information that can be deleted:

• An email address if more than one email address exists for the person.

• A phone number if more than one phone number exists for a person.

• An address if more than one address record exists for a person.

Tags
To assign, view, or remove tags, search for the person in the Person Profiles work area.

Click Attributes on the person profile page for general type tags. For example, assign an attribute tag named Military to
a person.
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Click the Service Holds tab for service hold type tags. When assigning a service hold tag, you can:

• Indicate whether the end user, to whom the hold is assigned, can view the hold on their My Account page.

• Specify the duration of the hold.

• Edit information on how to resolve the hold, such as mitigation steps, mitigation contact, and so on.

Self-Service
Self-service users, such as students and applicants, can:

• View or edit personal information, such as name and contact information.

• View a summary of academic data, such as the enrolled academic program.

• View received communications, such as an applicant admitted confirmation.

• View service holds tags assigned to them, if the administrator has selected the Visible to Recipient option.

• Assign general tags to themselves.

• View national identification information.

• View residency information.

• View admissions applications.

• Review assigned tasks and checklists.

• View or edit the locale preferences, such as preferred date format and time format.

• View their relationship with another person in a managed student group.

Profile Option for Missing Person Contacts
To enable the Missing Person Contacts section on the Emergency Contacts page, set the
ORA_HEY_MISSING_PERSON_CONTACT_ENABLED profile option. Use the Manage Administrator Profile Values task in
the Setup and Maintenance work area to manage profile options.

Find the Customer Account ID of a Person  
A person's customer account ID is used to find relevant financial transactions. You may want to use a student's
customer account ID as a parameter when making API calls.

1. In the Setup and Maintenance work area, use the Manage Customers task:

◦ Offering: Student Management

◦ Functional Area: Customers

Make sure all tasks appear.

2. On the Manage Customers page, in Customer Type, select Person.
3. Search for the person.
4. In the results, select the person's name. Some details of that person's account appear below the results. For example,

<Person's name>: Accounts.
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5. In View, select All so that all columns appear.
The customer's account ID appears in Original System Reference for Customer Account.
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4  General Settings

Age Settings  
Configure age limits to identify a person as fully managed, jointly managed or self-managed.

Here are the differences between the age limit management levels for a person:

• A fully managed person's actions are controlled by another person. For example, a child under the age of 13 in
the United States whose actions are managed by a parent.

• A jointly managed person's actions are shared with another person. For example, a teen whose actions are
shared with a parent.

• A self-managed person controls their own actions, for example, an adult.

To configure the Age Limits:

1. From Student Central, click Search and search for Age Settings.
2. Move the self-managed age slider to set the age limit.

Task Settings  
Prompt a student or administrator user to mark a document submission task complete if the document has already
been uploaded when leaving the details page for the task.

Configure whether to turn on or off these behaviors at a global level in Student Management.

1. From Student Central, click Search and search for Task and Checklist Settings.
2. Click the toggle button to enable Request User to Mark Document Submission Tasks Complete setting.

When a document submission task is marked complete, Student Management Cloud selects the default status
matching the Complete status type for the defined status scheme for that task.

9
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5  External Organizations

Manage External Organizations  
External organizations can include high schools, universities, sponsorship organizations, and so on.

Access the External Organizations page: From Student Central, click Search and search for Student Management
External Organizations.

Here are some things you can do on this page:

• Search for an external organization.

• Create an external organization.

• Assign identifiers, contacts, and locations to an external organization.

• Inactivate an external organization.

You can also use the Details tab to provide information to help in the Transfer Credit process:

• Select the term type and accreditation entity.

• Indicate that multiple organizations share the same set of external courses and course equivalences.

Transfer credit processing isn't currently available.

Difference Between Party ID and Organization Identifiers
When you create an external organization, the Cloud application automatically assigns a party ID. A Party ID is different
from an organization identifier. External agencies assign organization identifiers to enable information exchange
and reporting across educational institutions. Use the Identifiers tab to add an organization identifier. Here are some
examples of organization identifiers:

• A CEEB code that's assigned to a high school or college. These codes are used mostly in college entrance
exams such as the SAT.

• A NCES code that enables school officials to obtain the correct name, address, phone number, and other
characteristics of a public school or school district. The code is used in reporting institutional data through the
Integrated Post-secondary Education Data System (IPEDS).

Related Topics
• Identifiers

• Contacts

• Locations

11

https://www.oracle.com/pls/topic/lookup?ctx=fa24c&id=u30227469
https://www.oracle.com/pls/topic/lookup?ctx=fa24c&id=u30227470
https://www.oracle.com/pls/topic/lookup?ctx=fa24c&id=u30227471


Oracle Fusion Cloud Student Management
Using Student Management

Chapter 5
External Organizations

12



Oracle Fusion Cloud Student Management
Using Student Management

Chapter 6
Admissions

6  Admissions

Overview of Admissions Application Forms  
Admissions managers and their staff can create a variety of admissions application forms using Form Builder.

Prospective students then complete these program-specific application forms when they apply to your institution. You
can tailor each application to a program's requirements, and continue to edit their content even after students submit
them.

Application forms are in one of these version states:

• Draft

• Published

• Unpublished

Initially, the forms are created in a draft state. Over time, you can create additional versions from any other draft,
published, or unpublished versions.

To create new admissions forms and also to create additional versions of them, from Student Central, click Search and
search for Form Inventory.

Related Topics
• Associate Fees with Application Forms

• Implement Student Admissions

Admissions Applications Security  
Student Admissions Cloud utilizes the data access security framework to control access to admissions application
records. Applications can't be viewed or updated by anyone without the relevant data access permissions.

You can assign and manage all data access through data profiles by using the Manage Application Access task in the
Setup and Maintenance work area, Student Management offering.

Use data profiles to define data access by:

• Institution

• Academic level

• Academic group

• Program

• Campus

• Admit type

13
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You can control data access by role and individual user. For example, users will only see items in the applications list
that they have access to. You can also assign privileges, such as enabling some users to view applications and others to
update them.

Related Topics
• Control Data Access by Role

Configure Application Snapshot Settings  
View the point-in-time data for an admissions application based on application status. Applicants and administrators
can view, download, and print a copy of submitted applications or other available data snapshots for an application.

First, define snapshot settings for the admissions application form. Select which application statuses will trigger the
creation of a static snapshot view for applicants and administrators. Associate those settings with a specific institution,
campus, or other entity. Alternatively, you can choose to create a global setting at the system office level.

Then, use the new data security privileges to control which snapshot status points are available by user role. For
example, a Student role can be limited to accessing only the submitted status snapshot, whereas an Admissions
Coordinator role can view all available snapshot instances.

Here’s what you do.

1. From Student Central, click Search and search for Application Snapshot Settings.
2. Click Create Snapshot Setting and specify the required details, such as Setting Name and Code.
3. On the Snapshot Statuses tab, select and add different application statuses for which you want to save an

application snapshot.
4. On the Relationships tab, create a relationship to associate the snapshot settings with a specific institution,

campus, or other entity.

Next, enable the data security privileges to limit access for different roles, such as a Student role. By default, the
Student role doesn't have access to see any snapshot data until you enable data security privileges, and the Admissions
Coordinator role has access to all available snapshots.

On the Roles tab of the Security Console, make a copy of an existing student role, then edit the copy to create a new
user-defined-role. Or, if you already have a user-defined copy of an existing student role, edit that.

• To initiate a copy of an existing student role, search for the role. In the search results, click the arrow for the
selected role and select Copy Role  > Copy top role and inherited roles.

• To edit an existing user-defined student role, search for the role. In the search results, click the arrow for the
selected role and select Edit Role.

An editing train opens. Essentially, you follow the same process when creating a new user-defined role as you would
follow to edit one.

1. Click the Data Security Policies train stop.
2. On the Data Security Policies page, find the two Admissions Application Grant Policies, then click the arrow at

the end of the policy row to see the actions menu.
3. Select the Remove Data Security Policy option.
4. Click Submit and Close, then click OK to close the confirmation message.

14
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Now, create a mapping between a data profile and the user-defined role.

1. From Student Central, click Search and search for Application Access.
2. Click Data Profiles >  New Data Profile.
3. Specify a name and description for the profile.
4. In the Assigned Business Object field, select Admissions Application. To see the fields associated with that

business object, click inside the Fields field.
5. In the Securing Fields, select Row Type, Application Status.
6. When you're done, click Save. The data profile that you created is displayed on the list.
7. Click the ellipses on the row for the data profile you just created and click Assign to Roles. If you don't see the

ellipses, scroll to the right.
8. On the Assign Data Access to Roles page, click Add Role, select the user-defined role to add to the data profile,

and click Add.
9. For each of the fields that you enabled for the data profile, select the values to define the security filter

conditions on the data set for the business object. For example, when you select Row Type: Snapshot,
Application Status: Submitted, and Permissions: View Admissions Application, users associated with the
assigned user-defined role can view snapshots with a submitted status.

10. When done, click Add.
11. Use the Add Row option to add more security filter conditions on the data set for the business object.
12. When done, click Save.

Related Topics
• Control Data Access by Role

Build a New Application Form  
Click Build Form to create a new one, or click Duplicate for an existing form to start a new application form based on it.

Here, Form Builder takes you to the Details tab, where you must first name the new application form, add a Form Code,
and associate it with these specific attributes:

• Institution

• Campus

• Academic level (such as undergraduate or non-degree)

• Admit type (such as new student or transfer)

• Admit start type (such as a specific date range or one or more admit periods)

• Academic group (such as the School of Nursing or College of Fine Arts)

• Academic programs associated with the academic group

All these details become associated with the draft version of the form when you create it. The Design, Attachments,
and Preview tabs for this form work the same for new forms as they do when creating versions.

On the Design tab, these sections are prepopulated:

• Names
Applicants must enter one or more name types. They can enter one or more names, and set one as preferred.
They can also specify their name in the last name field if they have or use only a single name.

• Actions

15
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Click any section, then click Add Sections to see a list of new items available to add to that form. Here's the current list
of new sections available:

• Academic History

• Addresses (applicants can enter one or more, and set one as preferred)

• Biographical Information (including race, ethnicity, gender identity, and preferred pronouns)

• Blank Section

• Emails (applicants can enter one or more, and set one as preferred)

• Emergency Contacts (applicants can enter one or more, and set one as preferred)

• Extracurricular Activities

• Phones (applicants can enter one or more, and set one as preferred; you can require a minimum number of
phone numbers to be entered)

• Recommendations

• Relationships

Use the controls Move Up and Move Down to rearrange the section order. You can also Add Fields to a section and use
the same controls to rearrange their order. A Properties window appears when you click any section or field. Here are
some of the ways you can configure an application form using its properties:

• Change a field or section's label.

• Add inline text to appear below a field or section heading.

• Set a field value to required.

• Set a minimum number of addresses an applicant must enter.

On the Attachments tab, add an Attachment Group for similar attachments and then define meaningful display name
and category for that Attachment Group. This helps applicants understand the attachments they need to submit with
their application.

Note:  You can configure additional user-defined attachment categories by adding new lookup codes. Use the
Manage Student Management Lookups task in the Setup and Maintenance work area and search for the lookup type
ORA_HEY_CATEGORY_CODE. In the Lookup Codes field, click Add and configure additional user-defined lookup codes.

If you need to add multiple attachment groups, use the controls Move Up and Move Down to rearrange the attachment
group order. You can also add one or more attachment files to an attachment group and use the same controls to
rearrange their order. A Properties window appears when you click on any attachment group or attachment file. Here
are some of the ways you can configure an attachment group or an attachment file using its properties:

• Add an attachment group’s category or display name.

• Add the required attachment file’s name.

• Add inline text to appear below an attachment group or an attachment file heading.

• Set an attachment file to required.

Note:  Use the Application Composer, part of the Applications Core Configuration task, to create your own fields. For
example, you can create multiselect fields and text fields. Then, you can associate those field codes and lookup types
with a specific application form. Add those fields to a section of the form while working on the Design tab.

When you're satisfied with the application form's content and layout, click Publish to make it visible to end users and
applicants.
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Create an Application Form Version  
The versioning framework allows you to create and manage multiple versions of an existing draft, published, or
unpublished form.

On the Versions tab, click the ellipses on the row for the form and click Create Draft to start a new version based on it.

On the Details tab, you can update values for some specific attributes such as Campus, Admit Period, and so on.

On the Design tab:

• When you click a section of the form it becomes editable.

• When you click a section or a field, the Section Properties dialog box becomes available.

On the Attachments tab:

• When you click an attachment group it becomes editable.

• When you click an attachment group, the Attachment Group Properties dialog box becomes available.

• When you click an attachment file inside an attachment group, it becomes editable.

• When you click an attachment file, the Attachment Properties dialog box becomes available.

Here are some changes you can make using the editable form and properties:

• Add and remove sections.

• Add and remove fields within a section.

• Change the name or label of a section or field.

• Add additional descriptive inline text under a section name.

• Reorder sections or fields within a section.

• Change an attachment group’s category or display name.

• Change the required attachment file’s name.

• Update the inline text to appear below an attachment group or an attachment file heading.

• Indicate whether an attachment is required.

When you're done, click Preview to see your design changes before saving or publishing. When you publish this new
version, the previously published version automatically becomes unpublished.

You can also unpublish a published version at any time. If you do that, in-progress applications will maintain an
association with the version that was published at the time the application was started. As an administrator with the
Update Locked Student Management Forms security permission, you can make changes to an unpublished form to
correct any typographical errors on in-progress applications.

Associate Fees with Application Forms  
Institutions often charge an application fee when a prospective student applies to a program.
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Admissions managers and their staff can create multiple application fees and associate them with admissions
application forms. Once configured, prospective students must pay their application fee at the time they submit their
application. Applicants can complete the fee payment transaction within the context of the admissions application.

To associate an application fee with an application form, here's what you need to do:

• Create an application fee.

• Link the application fee to the application form.

After you associate an application fee with an application form, anyone applying to that program must not only
complete the form but also pay their application fee at that time. The Make a Payment page displays any valid fee
discounts (such as for early enrollment). Applicants select a payment method and continue through the payment
process, receiving a final payment status message at the end. Applicants can always go to their self-service Finances
page to see the application fees they paid for in their list of transactions.

Manage Submitted Applications  
Admissions managers can review the list of all prospective students who have applied to your institution. From there,
you can drill down into a completed application form to review or edit its details and make an admissions decision.

To view a list of submitted admissions applications, from Student Central, click Search and search for Application List.
Here's what you can do.

• Search for specific admissions applications by applicant name, email, party ID, or constituent ID.

• Use Advanced Search to add or remove multiple search criteria, such as Academic Level, Admit Type,
Academic Group, and so on.

• Click Show Filters and filter the search results further to drill down into specific applications for reviewing.

• Sort on any of the column headers to reorder the list of search results.

Overview of Standardized Tests  
Define which standardized tests will be recorded for applicants and students. Associate the components to the test
along with valid score ranges for each component.

To go to the Manage Standardized Tests landing page, from Student Central, click Search and search for Standardized
Tests.

You can enter the component score results for each test and record different test attempts by test date.

To go to the Student Test Results landing page, from Student Central, click Search and search for Student Test Results.

Related Topics
• Manage Student Test Result

• Configure Standardized Test

18

https://www.oracle.com/pls/topic/lookup?ctx=fa24c&id=u30246872


Oracle Fusion Cloud Student Management
Using Student Management

Chapter 6
Admissions

Review an Application  
Click Applicant Name to open and review an admissions application and its associated attachments.

You have a lot of options here:

• Change an application's evaluation status.

• Assign yourself as the admissions reviewer.

• Assign a new task or checklist to the application, which triggers an email to the applicant with a list of items to
submit or further steps to complete.

• Directly edit application content on behalf of the prospective student, including adding new attachments or
recommendation details.

• View a printer friendly version of the admissions application form submitted by an applicant. You can view,
download, and print a copy of an application.

• View and download any files attached to the application.

Related Topics
• Define Admissions Application Action Reasons

• Overview of Tasks and Checklists

Evaluate an Application  
When an application is assigned to you, either after you have assigned yourself or someone else has assigned you to it,
click Evaluate to begin the admissions review process.

After this step you can't edit the application's content, but you can still update the evaluation status.

Here are some actions you take when you evaluate an application:

• Review all submitted content.

• Assign an evaluator.

• Create checklists to collect additional information required to make an admissions decision.

• Track when checklist tasks are complete and monitor the emails that the checklist generates to applicants.

• Enter an admissions decision.

When you're finished, select your Admissions Decision (such as admit, deny, or waitlist) and enter any additional
comments associated with your decision before saving. Admissions application action reasons are set up using the
Manage Admissions Application Action Reasons task in Functional Setup Manager.

Students can monitor their application throughout the evaluation process, and respond to checklist task requests, using
the self-service Applicant Dashboard.

Related Topics
• Overview of Tasks and Checklists
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Cancel or Withdraw an Application  
Sometimes, an applicant's plans change or they're unable to complete all of the admissions steps to meet an
institution's deadlines. In cases like these, admissions administrators can cancel an application for them.

An administrator can also withdraw an application on behalf of an applicant who submitted their application but no
longer wants to be considered for admission (because, for example, they no longer plan to attend a program or plan to
attend a different program). You can also create event-based communications, tied to an application's status change,
that notify the applicant.

Cancel an Application
You can cancel any incomplete application, either in-progress or submitted. Click Actions  > Cancel application and
select an action reason. This action automatically pauses tasks that are not completed for an admissions application
when the application is canceled.

When you're done, the application status changes to reflect the cancellation and the application is no longer available to
edit in self service. Instead, the applicant will see the new canceled status.

Withdraw an Application
You can withdraw any application with a Submitted application status. Click Actions  > Withdraw application and
select an action reason. This action automatically pauses tasks that are not completed for an admissions application
when the application is withdrawn.

When you're done, the application status changes to reflect the withdrawal and in self service the applicant will see that
their application has been withdrawn.

Revert an Application
For any canceled or withdrawn application, you can revert it to its previous status. Click Actions  > Revert application
and select an action reason. This action automatically marks tasks that were paused as incomplete when a previously
canceled or withdrawn admission application is reverted out of those states.

When you're done, the application reopens with its previous status. If the application had been in progress when
canceled, the applicant can then complete it. If the application had been submitted when canceled or withdrawn, the
applicant can once again see its submitted status and the administrator can evaluate it.

Related Topics
• Define Admissions Application Action Reasons

• Create a Communication

Reapplication  
Reapplication is common in many institutions.
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For example, an applicant who has been denied for a program can reapply for entry on a different start date. Or,
applicants who have attended a program and want to repeat it in a different academic period (such as a precollege
program) can reapply for consideration.

Form Builder supports reapplication, allowing students and prospective students to reapply to an academic program
for consideration on a different admit start date range or academic period. On the Applications list page, administrators
can view and sort by Admit Start Type, Admit Start Date, and Admit End Date. They can also see if an application
is a Reapplication. When an administrator views a reapplication they can click the Other Submissions link to view all
previously submitted applications to the same program.

Enable Program Application by Group Manager  
You can see clear messaging when a program is eligible for a group manager to apply to your institution on behalf of
another student, such as a parent submitting an application for their child.

Before a group manager user can complete an application on behalf of a student, they need to add the student to their
managed student group. The group manager gets clear alerts when students haven't been added to the managed
student group and while managing them in a managed student group. Then, at application time Form Builder asks
which user account the application is for, and associates the appropriate person ID with the rest of the application
process. The group manager can create, view, and update the associated student's application as well as their person
profile.

Related Topics
• Manage Persons

• Create Managed Student Groups
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Academic Periods  

Overview of Academic Periods  
An academic period is the date foundation for scheduling course sections, student enrollment, and automatic fee
calculation.

It sets the parameters for when a student searches for courses, adds to the shopping cart or student scheduler, and
enrolls.

The academic period feature offers maximum flexibility for institutions. You can configure multiple flexible time periods
for an academic structure. You can also accurately mirror your academic calendars and provide more flexibility for
academic periods that don't fit into the usual term or semester construct.

You can define structures that support semesters, terms, quarters, and any other flexible time period. For example, set
up a fall term or semester with many courses that follow the same deadline dates, or a 1 day course with dates that only
apply to that course. You can also group academic periods together into an academic reporting period for reporting
purposes.

Note:  As of 22D you can use existing self-paced periods, but you can’t create self-paced periods. You'll be able to
create self-paced periods in a future release. Holiday periods also aren't available as of 22D.

Related Topics
• Create and Manage Academic Periods

• Create and Manage Academic Period Attribute Dates

Search for Academic Periods  
Search for and view academic periods.

From Student Central, click Search and search for Academic Periods.

You can search for a period by name. Or use advanced search criteria such as period type, academic calendar, and tags.

You can also filter search results by period type and tags.

Create and Manage Academic Periods  
An academic period is a timespan, such as a term or semester, which contains course sections typically offered within
that timespan.
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Academic periods are also a way to define date spans for other features such as courses.

Note:  As of 22D you can use existing self-paced periods, but you can’t create self-paced periods. You'll be able to
create self-paced periods in a future release. Holiday periods also aren't available as of 22D.

Prerequisite Features
Set up these features before you create academic period attribute dates and academic periods:

1. Manage Time Zone Settings Time Zone Settings

Required if you use a calculation method of Manual Entry and a date type of Date Time on academic period
attribute dates and academic periods.

2. Academic Institution Academic Institutions

Required for academic periods.

Configure academic period attribute dates before you create academic periods. Create and Manage Academic Period
Attribute Dates

How to Use Academic Periods
To access the Academic Periods page: From Student Central, click Search and search for Academic Periods.

You can associate periods with each other to create period hierarchies. For example, create academic periods for fall and
spring semesters. Then associate those periods with an academic reporting period for the academic or calendar year.

When you create a period with a period type of academic, you must associate that period with an academic reporting
period in the period hierarchy.

Here are some things that you can do when you create an academic period:

• Flexibly decide the attributes for the period. For example, remove an attribute if it's not relevant to a period.

• Edit the date setup for an attribute. For example, change the calculation method. The updated setup applies
only to the particular period.

• Associate an academic or academic reporting period with one or more academic institutions.

• Create a period hierarchy to define the relationship between academic periods and academic reporting periods.
An academic period can be a child of an academic reporting period only when the start and end dates of the
academic reporting period are inclusive of the child period date span.

For step-by-step information about how to create an academic period, start with the Add Details for Academic Periods
topic. Add Details for Academic Periods

Then follow the topics in order (one topic for each tab on the Academic Periods page) until you finish creating the
academic period.

Rapid Implementation
You can use Rapid Implementation to create and load academic periods. Use these tasks in the Setup and Maintenance
work area, Student Management offering:

• Create Academic Periods in Spreadsheet

• Upload Academic Structures in Spreadsheet
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Related Topics
• Overview of Academic Periods

• Rapid Implementation for Oracle Student Management Cloud

Add Details for Academic Periods  
When you create an academic period, enter details such as start and end dates and period type.

Note:  As of 22D you can use existing self-paced periods, but you can’t create self-paced periods. You'll be able to
create self-paced periods in a future release. Holiday periods also aren't available as of 22D.

1. Access the Academic Periods page: From Student Central, click Search and search for Academic Periods.
2. Click Create Academic Period.
3. Enter a start and end date.

Create periods that mirror your institutional academic calendar and course offerings.
4. Enter a unique name and code.

The code identifies a unique period record when you import and export data between environments.
5. Enter a period type.
6. Enter the number of weeks of instruction.

This is a required field but currently has no functionality.
7. Assign tags to academic periods to differentiate different types of academic periods such as semesters and

trimesters.

For more information, see the Tags section in this topic.
8. You can enter an optional description to provide further information and help identify similar named periods.
9. Click Create. Here's what happens:

◦ The data you entered is saved as the Details tab.

◦ The period is saved as inactive.

◦ The other tabs of the page are displayed: Period Attribute Dates, Ownership, and Period Hierarchy.

◦ Default dates display on the Period Attribute Dates tab. Add Period Attribute Dates for Academic Periods

Tags
The tags you can assign to an academic period are the tags that are associated with the Academic Period tag group.
You can add or remove tags from a tag group on the Manage Attribute Tags page. Attribute Tags

After you create academic periods, you must run a process to associate periods with academic calendars. For example,
organize 2023-2024 Fall, Spring, and Summer periods into an academic year calendar.

The process is Sync Academic Periods to Academic Calendars. To run the process, click Navigator and in the Tools area,
click Scheduled Processes. Here’s what the process does:

• Creates and syncs academic calendars corresponding to reporting periods.

• Maps academic periods within the reporting periods to the corresponding academic calendars.
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Note:  You must run the sync process regularly to make sure that newly created or updated academic periods are
associated with the correct academic calendar. Newly created periods aren’t associated with an academic calendar
until you assign them to a parent reporting period and run the Sync Academic Periods to Academic Calendars
process. This process is an essential step to ensure that users can select the correct academic period when they
manage courses and course sections.

Add Period Attribute Dates for Academic Periods  
Add and edit period attribute dates for an academic period.

Click the Period Attribute Dates tab.

The default attribute dates on this tab automatically display when you click Create to create an academic period. Add
Details for Academic Periods

The attribute dates are based on a match between the period type and the period attribute tag. You select the period
type when you create a period. You associate tags with a period attribute date on the Academic Period Attribute Dates
setup page. Create and Manage Academic Period Attribute Dates

Add Period Attribute Dates
How and where you use period attribute dates depends on your academic calendars and structures, and the time length
of your academic periods. Associate the tuition calculation attributes with academic reporting periods if required. But
for other attributes, it’s useful to associate them with academic periods. This means you can have more granular control
of the period attribute dates.

Here’s how you add a period attribute to a period:

1. Click Add Period Attribute.
2. Select the period attribute.
3. Select a calculation method of Manual Entry or Pivot.

◦ Manual Entry:
i. For manual entry method, select a date type and enter the required data.

ii. Click Save.
◦ Pivot:

i. Enter the required data and click Calculate.
The calculated date based on the pivot settings is displayed.

ii. Click Save to save the calculated date.

Remove Period Attribute Dates
To remove a period attribute from a period, click the ellipsis for the attribute and select Remove.

Edit Period Attribute Dates
To edit a period attribute date, click the ellipsis for the attribute and select Edit Attribute.

You can select a different calculation option, either manual or pivot.

You can also edit the date for a calculation method.
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For manual entry method, make your changes and click Save.

For pivot method, use these steps:

1. Edit one or more pivot fields.

When you edit at least one field, the Calculate button becomes active.
2. Click Calculate to recalculate the date.
3. You must save the record for the recalculated dates to be saved.

To update the tuition calculation attribute dates on an academic reporting period, use a date type of range. This means
you can specify a start and end date for the attribute.

Add Ownership for Academic Periods  
When you create an academic period, add ownership details.

1. Click the Ownership tab.
2. Click Assign Ownership.
3. Select an institution. If the period is shared between institutions, you can add more than one institution as the

owner.

Your selections appear in the Current Selections box.
4. Click Assign and then click Save.

Create a Period Hierarchy for Academic Periods  
Create a period hierarchy to define the relationship between academic periods and academic reporting periods.

Note:  As of 22D you can use existing self-paced periods, but you can’t create self-paced periods. You'll be able to
create self-paced periods in a future release. Holiday periods also aren't available as of 22D.

You must associate an academic period with a parent academic reporting period. Add a parent reporting period to an
academic period. Or add a child academic period to a reporting period. A child academic period date span must fall
within the start and end dates of the parent reporting period.

You can also create parent and child relationships between different reporting periods. Again, the child reporting period
date span must fall within the start and end dates of the parent reporting period.

Here are the steps to create a period hierarchy, using the example of adding a parent reporting period to an academic
period.

1. Click the Period Hierarchy tab.
2. Click Add Period.
3. Select a reporting period as the parent period.

Your selection appears in the Current Selections box.
4. Click Add.

You can see the hierarchy of the parent reporting period and the child academic period.
5. Click Save.
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When you're ready, activate the academic period. Activate Academic Periods

Activate Academic Periods  
Activate an academic period after you complete the required setup.

Note:  As of 22D you can use existing self-paced periods, but you can’t create self-paced periods. You'll be able to
create self-paced periods in a future release. Holiday periods also aren't available as of 22D.

Before you can set an academic period to active, you must complete this setup:

1. Details tab

◦ Start and end date.

◦ Name and code.

◦ Period type and weeks of instruction.

2. Period Attribute Dates tab: All attributes must have a calculated or manual date.
3. Ownership tab: Assign at least one institution.
4. Period Hierarchy tab: Associating an academic period with an academic reporting period.

Copy and Delete Academic Periods  
You can copy an academic period and use it as a template to create another period.

From Student Central, click Search and search for Academic Periods. Then select a period and click Copy.

Note:  Only fields on the Details tab are copied to the new period record. You need to configure and update the Period
Attribute Dates, Ownership, and Period Hierarchy tabs.

You can also delete periods. However, if a period is assigned to course sections you shouldn’t delete it. To delete a
period, make the period inactive, save the record, and then click Trash.

Period Sequences  
Create a chronological sequence of academic reporting periods that mirrors the institutional calendar.

You must create period sequences as part of the required setup for the Student Course Schedule. Configure Your
Academic Structures for the Student Course Schedule

Create reporting period sequences by institution and academic level. For example, you might create an undergraduate
sequence and a graduate sequence. Or when the institutional calendar is the same for both undergraduate and
graduate, you might create a sequence that's shared between undergraduate and graduate students. The sequences
you create provide a time line of study for students in their Course Schedule. The period in which a sequence begins is
based on the admit period at the academic group level in the student program record.
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Access the Academic Period Sequencing page: From Student Central, click Search and search for Academic Period
Sequencing.

When you create a sequence, enter a sequence name and then select an institution and academic level.

To add sequence periods, click Add Period, search for reporting periods by date range, and select the periods. You can
go back later and add more periods for the sequence as needed. After you add the reporting periods, you can see them
listed in order for the sequence. You can expand a period to view the academic periods associated with it (informational
only).

You can indicate that a reporting period is optional. For example, if you select the Optional check box for a Summer
period, that period doesn't show automatically in a student's course schedule but the student can add the period to
their schedule.

Related Topics
• Create and Manage Academic Periods

Academic Staff Assignments  
You must create a staff assignment for each academic institution and academic organization that offers courses or
programs. You can create assignments only for staff members who already exist in the TCA Party table as a person.

Access the Manage Academic Staff page: From Student Central, click Search and search for Manage Academic Staff.

To create a staff assignment or edit an existing assignment, search for and select a staff member.

Note:  You must associate all contacts (course), staff (course sections), and advisors (student program) with the
appropriate academic institution and academic organization.

You can optionally assign staff to a subject area, catalog number, and campus. You can also add biographical
information about the staff member and format that information.

Rapid Implementation
You can also create and load academic staff assignments using the Rapid Implementation process. Use these tasks in
the Setup and Maintenance work area, Student Management offering:

• Create Academic Staff in Spreadsheet

• Upload Academic Structures in Spreadsheet

Related Topics
• Academic Institutions

• Campuses

• Academic Subjects

• Academic Organizations

• Rapid Implementation for Oracle Student Management Cloud
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Courses and Course Sections  

Overview of Courses and Course Sections  
A course represents an element of teaching, learning or research within a specific subject area.

Courses are assigned a single academic organization ownership based on the subject you select when you create the
course. This controls which organization has responsibility for the course, such as academic department.

You can add various data for a course such as result types, fees, identifiers, contacts, and requisites.

After you create a course, you can schedule the course sections, in which students enroll. You can create meeting
information for a section so that students know when and where the section is available and the staff assigned to the
section.

Ultimately, students can search and view their courses in the course catalog, program requirements, student schedule,
and enroll in selected course sections.

Access the Courses page: From Student Central, click Search and search for Courses.

Access the Course Sections page: From Student Central, click Search and search for Course Sections.

Search for Courses and Course Sections  
Search for and view a course or course section.

From Student Central, click Search and search for Courses.

From Student Central, click Search and search for Course Sections.

Search for a course or course section using any part of the title, subject, or course number.

Use advanced search for more search options. For example, search by an entity type such as institution or campus.

Features to Set Up Before You Create Courses and Course Sections
 
You must set up some required features before you create courses and course sections.

Here’s the list of required features:

Feature More Information

Academic Period Attribute Dates
 

Create and Manage Academic Period Attribute Dates
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Feature More Information

Academic Periods
 

Create and Manage Academic Periods
 

Academic Subjects
 

Academic Subjects
 

Fees
 

Required for course fees.
 
Student Fees
 

Manage Result Types
 

Required for grading.
 
Result Types
 

Manage Result Sets
 

Required for grading.
 
Result Sets
 

Academic Institutions
 

Academic Institutions
 

Campuses
 

Campuses
 

Academic Organizations
 

Academic Organizations
 

Academic Levels
 

Academic Levels
 

Time Zone Settings
 

Time Zone Settings
 

Here's a list of optional features you might set up before you create courses and course sections:

Feature More Information

Manage Curriculum Tags
 

Required to display course cards on the Learning Catalog (New, Popular, Area of Study).
 
Curriculum Tags
 

Student Management Identifiers
 

Identifiers
 

System Offices
 

Whether entities such as system offices are required depends on your institutional structure. System
Offices
 

Requisite Schemes
 

Required if courses have prerequisites.
 
Requisite Schemes
 

Academic Program
 

Required for program requisites and to assign course requirements.
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Feature More Information

Create Programs
 

Buildings and Facilities
 

Required for course section meetings.
 
Buildings and Facilities
 

Manage Academic Staff
 

Required for the addition of academic staff such as instructors to Contacts and Course Meeting
Information.
 
Academic Staff Assignments
 

There are also some lookups that are required before you can create courses and course sections. Student Management
Lookups

Setup Feature Lookup Code More Information

Status
 

Course: ORA_HER_COURSE_STATUS
 
Course Section: ORA_HER_SECTION_STATUS_
CODE
 

Predefined values are available.
 

Course Types
 

ORA_HER_COURSE_TYPE
 

Required for the creation of meetings.
 

Here are the optional lookups:

Setup Feature Lookup Code More Information

Instructional Method
 

ORA_HER_CURRICULUM_FORMAT_CODE
 

Predefined values are available.
 

Descriptive Text Type
 

ORA_HER_MESSAGE_TYPE_CODE
 

Predefined values are available.
 

Create Courses  
Create courses and then course sections in which students can enroll. You must create courses before you create course
lists, academic groups, and programs.

Note:  Before you begin, review the list of features that you must set up before you can create courses. Features to Set
Up Before You Create Courses and Course Sections

Here's how you begin to create a course:

1. Access the Courses page: From Student Central, click Search and search for Courses.
2. Click Create Course.
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For step-by-step information about how to create a course, start with the Add Details for Courses topic. Add Details for
Courses

Then follow the topics in order (one topic for each tab on the Courses page) until you finish creating the course.

Rapid Implementation
You can also create and load courses using the Rapid Implementation process. Use these tasks in the Setup and
Maintenance work area, Student Management offering:

• Create Curriculum Items Configuration in Spreadsheet

• Upload Curriculum Structures in Spreadsheet

Related Topics
• Rapid Implementation for Oracle Student Management Cloud

Add Details for Courses  
When you create a course, enter details such as start period, type of units, and repeat option.

1. Access the Courses page: From Student Central, click Search and search for Courses.
2. Click Create Course.
3. Enter data in the Course Information section.
4. After you complete at least the required fields, click Next.
5. Enter data in the Repeats section.
6. After you complete at least the required field, click Next.
7. Enter data in the Units section.
8. After you complete at least the required fields, click Next.
9. Before you create the course, you can edit the Course Information, Repeats, and Units data.

Note:  After you create the course, you can’t update the subject or course number.

10. When you're ready, click Create.

The data you entered shows in the Details tab.

Note:  When you create a course, the status is set to Inactive. You must complete all required fields and assign
ownership and academic level before you come back to the Details tab and set the course to Active.

Course Information
Filter periods based on academic calendar to select a start or end period for the course.

For the start period, select the academic period in which the course is originally offered. You can select an end period.
Or, if the course doesn’t have a specific end date, select the No end period check box.

The course number is alphanumeric and is the course catalog reference.

You must enter a default enrollment capacity, but the value can be 0. You can edit the capacity on the course section.
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Select Available in catalog to allow users to search for the course in the Learning Catalog and Student Course
Schedule.

Select Allow save to wish list to allow users to add the course to a wish list in the Learning Catalog.

You can assign tags to a course. Curriculum Tags

Click Change to add or change an image for the course. You can resize and center the image. The image displays on the
course cards in the Learning Catalog and Student Course Schedule.

Repeats
Set up enrollment repeat checking to control what happens when a student tries to enroll in a previously completed
course.

Repeat limits are enforced only on enrollment. For example, a student enrolls in a course and a matching entry is found
in the student’s enrollment history. This is considered a repeat of the course.

With repeat checking setup, you can indicate these things:

• Whether a student can repeat a course.

• How many units a student can earn for multiple completions of a course.

The maximum number of units includes units earned in the original and repeat completions.

• How many times a student can repeat (complete) a course.

The maximum number of completions includes the original and repeat completions.

• Whether a student can enroll in multiple sections of a course in the same enrollment period. For example, a
student might be approved to take two different History-independent studies, each with a different supervisor
and topic area title.

If you indicate the course is repeatable, these fields are required: Total Units Allowed, Total Completions Allowed,
Allow multiple enrollment.

You must select an enrollment repeat option whether the course is repeatable or not. If the course isn’t repeatable select
None.

A student is considered to have completed a course if the student previously enrolled in the course (the student's
enrollment status was Enrolled).

Select an enrollment repeat option to indicate how the enrollment process handles course repeats:

Enrollment Repeat Option What Happens When a Student Tries to
Enroll in a Previously Completed Course

Student Enrollment Outcome

None
 

Course repeat limits aren't enforced.
 

The student can repeat the course without
restrictions.
 

Warning
 

The repeat checking routine runs based on the
repeat setup for the course.
 

The student can enroll in the course but
receives a warning message. For example,
 the student is reminded of their previous
enrollment.
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Enrollment Repeat Option What Happens When a Student Tries to
Enroll in a Previously Completed Course

Student Enrollment Outcome

Error
 

The repeat checking routine runs based on the
repeat setup for the course.
 

The student can't enroll in the course and
receives an error message.
 

Units
Select fixed or variable units.

You can’t override fixed units on the course section. You can override variable units on the course section.

You can indicate variable units for a course such as a minimum of 3 and a maximum of 4. Students can then select the
number of units to enroll in. An example is a course where the units vary based on the amount of work a student must
complete.

You can configure fixed course enrollment units and billing units with decimal values in addition to whole integers. You
can configure up to 2 decimal places.

For required fields, you can enter 0.

You can use Contact Hours or Other Units to record clock hours. These fields are for reporting only.

Next Step
Your next step is the Administrative Data tab. Add Administrative Data for Courses

Rapid Implementation
You can also create and load courses using the Rapid Implementation process. Use these tasks in the Setup and
Maintenance work area, Student Management offering:

• Create Curriculum Items Configuration in Spreadsheet

• Upload Curriculum Structures in Spreadsheet

Related Topics
• Rapid Implementation for Oracle Student Management Cloud

Add Administrative Data for Courses  
When you create a course, enter administrative data such as course types, result types, and fees.

1. Click the Administrative Data tab.
2. Enter data in the Course Types section.

If you select all available course types, Add Row becomes unavailable.
3. Click Result Types.
4. If the course is gradable, add at least one result set for Course Result Types.
5. If you add more than one result set, indicate which set is the default.
6. If relevant, add a midterm result type:

a. In the Other Result Types section, select a result type of Midterm Result.
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b. Select a result set.
You can select multiple result sets.

7. Click Fees.
8. Adding fees is optional. Here's how you add a fee:

a. Click Add Fee.
b. Search for the fee.
c. Click the fee to add it to the Current Selections box.
d. When you’ve completed your selections, click Add.

9. Click Save.

Course Types
Course types represent the component of a course such as lab, lecture, and tutorial. Only the course types that you add
here are available for you to select when you create meetings for course sections.

Configure course types in Manage Student Management Lookups, with the lookup code ORA_HER_COURSE_TYPE.
Features to Set Up Before You Create Courses and Course Sections

Instructional methods indicate how the course is offered, such as in person, online or blended. This isn't a required field.
Only the methods you select here for the course are available for when you create course sections. If you don’t select a
method for the course, all methods are available when you create course sections.

Result Types
The result sets that are available to select are sets that are associated with the Course Result or Midterm Result type
on the Manage Result Types page. Result Types

Only result types that you add here for the course are available for the course section.

Fees
You can attach fees such as a course fee or materials fee if required. Or you can attach fees when you create the course
section.

Select Pay to enroll to indicate that students must pay for the course before they enroll in it, such as for Continuing
Education enrollment and payment flows. Here's what happens in self-service:

• If you select this option and attach a fee for the course or course section, the fee shows in self-service pages.

• If you select this option and don't attach a fee for the course or scheduled course, Free shows in self-service
pages.

• If you don't select this option, no fee information shows in self-service pages. An example is a course that's part
of a traditional enrollment flow.

Next Step
Your next step is the Identifiers tab. Add Identifiers for Courses

Rapid Implementation
You can also create and load courses using the Rapid Implementation process. Use these tasks in the Setup and
Maintenance work area, Student Management offering:

• Create Curriculum Items Configuration in Spreadsheet
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• Upload Curriculum Structures in Spreadsheet

Related Topics
• Student Fees

• Rapid Implementation for Oracle Student Management Cloud

Add Identifiers for Courses  
When you create a course, you can add identifiers such as CIP codes.

Identifiers are optional. You can use identifiers to comply with regulatory and other reporting requirements.

The identifiers available for you to assign to a course are those that have been set up on the Identifiers page. Identifiers

1. Click the Identifiers tab.
2. Click Assign Identifier.
3. Search for the identifier.
4. Click the identifier to add it to the Current Selections box.
5. After you complete your selections, click Update.
6. Your next step is the Descriptive Text tab. Add Descriptive Text for Courses

Rapid Implementation
You can also create and load courses using the Rapid Implementation process. Use these tasks in the Setup and
Maintenance work area, Student Management offering:

• Create Curriculum Items Configuration in Spreadsheet

• Upload Curriculum Structures in Spreadsheet

Related Topics
• Rapid Implementation for Oracle Student Management Cloud

Add Descriptive Text for Courses  
When you create a course, add descriptive text to provide course information for staff, students, and guests.

Descriptive text is optional. You can enter a course description which is visible in self-service pages, such as the catalog.
You can enter other information such as course requirements or course materials.

1. Click the Descriptive Text tab.
2. Click Add Descriptive Text.
3. Select a type and then add your text.

Configure descriptive text types in Student Management Lookups, using the lookup code
ORA_HER_MESSAGE_TYPE_CODE. Features to Set Up Before You Create Courses and Course Sections

4. If you select Display on Course, the descriptive text displays for the course in self-service pages.
5. If you select Display on Student Record, the descriptive text displays on a student’s enrollment record. For

example, you might display information about course requirements but not course materials.
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6. Select Copy to course section for the descriptive text to appear on the course section.
7. Click Add.

You can add multiple text types. You can also use the ellipsis to edit, reorder, or remove existing descriptions.

Your next step is the Contacts tab. Add Contacts for Courses

Rapid Implementation
You can also create and load courses using the Rapid Implementation process. Use these tasks in the Setup and
Maintenance work area, Student Management offering:

• Create Curriculum Items Configuration in Spreadsheet

• Upload Curriculum Structures in Spreadsheet

Related Topics
• Rapid Implementation for Oracle Student Management Cloud

Add Contacts for Courses  
When you create a course, you can assign staff contacts to the course.

Assigning contacts is optional.

Staff are available to select as course contacts only if they've been configured as staff assignments in the Manage
Academic Staff page. Academic Staff Assignments

1. Click the Contacts tab.
2. Click Assign Contact.
3. Search for a contact.
4. Click the contact’s name to add them to the Current Selections box.

You can add multiple contacts.
5. Click Update.
6. Review the role for each course contact and change if necessary.
7. Select a primary contact for the course.
8. If you select Display on Course, information about the staff person, such as contact details, appears on the

course in student self-service pages.
9. Your next step is the Ownership tab. Add Ownership for Courses

Rapid Implementation
You can also create and load courses using the Rapid Implementation process. Use these tasks in the Setup and
Maintenance work area, Student Management offering:

• Create Curriculum Items Configuration in Spreadsheet

• Upload Curriculum Structures in Spreadsheet

Related Topics
• Rapid Implementation for Oracle Student Management Cloud
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Add Ownership for Courses  
When you create a course, you must assign ownership and an academic level.

1. Click the Ownership tab.
2. Click Assign Ownership.

You can assign only one entity type (an academic organization) as owner of a course. The available academic
organization is the one that has been assigned to the academic subject.

3. Click the entity.

It appears in the Current Selections box.
4. Click Assign.
5. Click the Actions ellipsis.
6. Click Edit Academic Levels to assign an academic level.

You must assign an academic level when you create a course.
7. Click Add Row and select an academic level.
8. Click Update.

To add requisites for the course, go to the Requisites tab. Add Requisites for Courses

If you don't need to add requisites for the course and you've completed your course data entry, here are the final steps
to create the course:

1. Go to the Details tab.
2. Change the status of the course to Active.

Note:  All required fields plus ownership and academic level data must be saved before you can set a course
to active.

Note:  A course must be active before you can create course sections.

3. Click Save.

Rapid Implementation
You can also create and load courses using the Rapid Implementation process. Use these tasks in the Setup and
Maintenance work area, Student Management offering:

• Create Curriculum Items Configuration in Spreadsheet

• Upload Curriculum Structures in Spreadsheet

Related Topics
• Rapid Implementation for Oracle Student Management Cloud

Add Requisites for Courses  
When you create a course, you can add requisites for the course.
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Adding requisites is optional.

Note:  Only course prerequisites and program requisites are currently supported.

If a course has both course and program prerequisites, a student must meet all prerequisites to enroll in the course.

When you add a course prerequisite, select a requisite scheme from those defined on the Requisite Schemes page. The
mapping in the setup page influences what happens when a student enrolls in a course that has a prerequisite. Requisite
Schemes

An example of a program prerequisite is an Economics major as a prerequisite for enrollment in an Economics course.

Here's how you add requisites:

1. Click the Requisites tab.
2. In the Course Prerequisites section, click Add Course.
3. Search for and click the courses that you want to add as prerequisites.

Courses are displayed in the Current Selections box.
4. Click Add.

If you add more than one course, the courses you add are treated as a list of courses which are all required to
meet the prerequisite.

5. Select a requisite scheme (required).
6. Follow similar steps to add program requisites. A program requisite ensures that a student can’t enroll in the

course section if the student isn’t associated with a program.

If you add more than one program, a student needs to be associated with only one of the programs, not all
programs, to satisfy the requisite requirement.

7. You can add a description about the requisites, which students can see in self-service pages.
8. After you finish adding your requisites, go back to the Details tab to complete creating the course.

Final Steps
Here are the final steps for creating a course:

1. Go to the Details tab.
2. Change the status of the course to Active.

Note:  All required fields plus ownership and academic level data must be saved before you can set a course
to active.

Note:  A course must be active before you can create course sections.

3. Click Save.

Rapid Implementation
You can also create and load courses using the Rapid Implementation process. Use these tasks in the Setup and
Maintenance work area, Student Management offering:

• Create Curriculum Items Configuration in Spreadsheet

• Upload Curriculum Structures in Spreadsheet
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Related Topics
• Rapid Implementation for Oracle Student Management Cloud

Edit Courses  
You can update data in one or multiple tabs and save your changes.

Except for the Details tab, updates to multiple tabs are saved independently of each other. Errors on a tab prevent data
on only that tab from being saved.

For example, you update both result types (Administrative Data tab) and descriptive text and save. Descriptive text is
saved even if there’s an error for result types.

Errors on the Details tab prevent the entire record from being saved.

Use the error panel to view and manage multiple errors across fields and tabs. When you edit a course, the error panel
appears when the first error occurs. Each subsequent error is added to the panel. In the error panel, click View to go to a
particular error.

Copy and Delete Courses  
When a course is active, you can copy it and use it as a template to create other courses with similar attributes.

Access the Courses page: From Student Central, click Search and search for Courses.

To copy a course, click the Duplicate icon.

Use the error panel to view and manage multiple errors across fields and tabs. When you copy a course, the error panel
appears when the first error occurs. Each subsequent error is added to the panel. In the error panel, click View to go to a
particular error.

You can delete a course if it's not associated with a course section. To delete a course, first set the status to Inactive on
the Details tab. Add Details for Courses

Create Course Sections  
After you create courses, create course sections. Students can search for and enroll in course sections.

A course must be active before you create course sections.

Note:  Before you begin, review the list of features that you must set up before you can create course sections.
Features to Set Up Before You Create Courses and Course Sections

Here's how you begin to create a course section:

1. Access the Course Sections page: From Student Central, click Search and search for Course Sections.
2. Click Create Course Section.
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For step-by-step information about how to create a course, start with the Add Details for Course Sections topic. Add
Details for Course Sections

Then follow the topics in order (one topic for each tab on the Course Sections page) until you finish creating the course
section.

Rapid Implementation
You can also create and load course sections using the Rapid Implementation process. Use these tasks in the Setup and
Maintenance work area, Student Management offering:

• Create Curriculum Items Configuration in Spreadsheet

• Upload Curriculum Structures in Spreadsheet

Related Topics
• Rapid Implementation for Oracle Student Management Cloud

Add Details for Course Sections  
When you create a course section, enter details such as academic period and enrollment capacity.

1. Access the Course Sections page: From Student Central, click Search and search for Course Sections.
2. Click Create Course Section.

The Next button becomes available when all required fields are completed.
3. Enter data in the Course Information section.
4. After you complete at least the required fields, click Next.
5. The Units section is displayed.

You can only update units for the course section if the unit value is Variable on the course setup.
6. Click Create.

The data you entered shows in the Details tab.

Course Section Information
Filter periods based on academic calendar and then select the academic period in which the course section is offered.

Select a course number from the list of all active courses based on the subject and period selected.

You can edit the title and enrollment capacity.

Select Available in catalog to allow users to search for the course section in the Learning Catalog and Student Course
Schedule.

You can assign tags to a course section. Curriculum Tags

Units
Fixed units defined for a course are used on the course sections. These units can include decimal values up to 2 decimal
places in addition to whole integers. Students can enroll in and receive credit for these partial unit course sections.
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How Academic Period Dates Impact Self-Service Pages
When you select an academic period for a course section, the dates associated with that period influence what happens
in student self-service. Create and Manage Academic Period Attribute Dates

Here are some examples:

• Course sections display for students if today's date is within the Search start and end dates.

• Students can save a course section to their wish list if today's date is within the Wish List start and end dates.

• Assuming that the enrollment capacity hasn't been reached, students can add a course section to their cart if
both these conditions are met:

◦ Today's date is within the Shopping Cart start and end dates.

◦ Today's date is within the Enrollment start and end dates.

Enrollment and Waitlist
The enrollment capacity data that you enter is used in validations that run when a student tries to enroll in a course
section. The number in the Total Enrollment field changes as students enroll. Students see an Available Seats count in
the Learning Catalog and in the Student Course Schedule.

Use the Waitlist Capacity field to set waitlist limits. The number in the Waitlist Enrollment field changes as
administrators add students to the waitlist for a course section which is full.

Rapid Implementation
You can also create and load course sections using the Rapid Implementation process. Use these tasks in the Setup and
Maintenance work area, Student Management offering:

• Create Curriculum Items Configuration in Spreadsheet

• Upload Curriculum Structures in Spreadsheet

Related Topics
• Rapid Implementation for Oracle Student Management Cloud

Add Administrative Data for Course Sections  
When you create a course section, enter administrative data such as course types, result types, and fees.

1. Click the Administrative Data tab.
2. Enter data in the Course Types section:

◦ Add only the course types that relate to this specific course section.

◦ To create meetings, you must add course types here.

◦ You can only add course types here if you added them during course setup.

3. Click Result Types if the course section is gradable.
4. Select Gradable.
5. Enter data in the Results Types section:

◦ Add only the result types that relate to this specific course section.
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◦ To grade the course, you must add result types here.

◦ You can only add result types here if you added them during course setup.

6. If relevant, use the Other Result Types section to add midterm result types.

You can only add result types here if you added them during course setup.
7. Click Fees.
8. Adding fees is optional. Course section fees aren't tied to the fees setup on the course.

Here's how you add a fee:

a. Click Add Fee.
b. Search for the fee.
c. Click the fee to add it to the Current Selections box.
d. When you’ve completed your selections, click Add.

9. Click Section Attribute Dates to add attribute dates for this section.

If you add drop attribute dates, the drop process uses these dates. For example, a particular course section
has a last date to withdraw which is different from the last date to withdraw for other sections in the academic
period. In this case, the drop process uses the date on the section to determine if and how a student can drop
the section.

If drop attribute dates don't exist for a course section, the drop process uses the academic period attribute
dates. Drop Schemes

Only drop attribute dates are used. Other attribute dates on the section (such as First Date to Enroll, Last Date
to Enroll) aren’t used during the enrollment process.

10. Click Save.

Course Types
Instructional methods indicate how the course is offered, such as in person, online or blended. This isn't a required field.
If you don’t select methods on course setup, all methods are available when you create course sections. If you select
methods on the course setup, only those methods are available when you create course sections.

Fees
An academic period fee is calculated based on the summarized billing units of courses in which a student is enrolled for
a specific reporting academic period. You can exclude the billing units for a course from the calculation.

Rapid Implementation
You can also create and load course sections using the Rapid Implementation process. Use these tasks in the Setup and
Maintenance work area, Student Management offering:

• Create Curriculum Items Configuration in Spreadsheet

• Upload Curriculum Structures in Spreadsheet

Related Topics
• Rapid Implementation for Oracle Student Management Cloud
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Add Descriptive Text for Course Sections  
When you create a course section, enter descriptive text to provide course information for staff, students, and guests.

1. Click the Descriptive Text tab.
2. If Copy to Section is selected for the course, text is copied from the course to each course section. You can edit,

remove, and reorder the text descriptions.
3. To add new text, click Add Descriptive Text.
4. If you select Display on Course, the descriptive text displays in self-service pages.
5. If you select Display on Student Record, the descriptive text displays on a student’s enrollment record.
6. Click Add.

Note:  Course section descriptive text doesn't currently display in the Schedule Options page in the Learning Catalog
and Student Course Schedule.

Rapid Implementation
You can also create and load course sections using the Rapid Implementation process. Use these tasks in the Setup and
Maintenance work area, Student Management offering:

• Create Curriculum Items Configuration in Spreadsheet

• Upload Curriculum Structures in Spreadsheet

Related Topics
• Rapid Implementation for Oracle Student Management Cloud

Add Ownership for Course Sections  
When you create a course section, view the ownership details.

The ownership details, including academic organization and academic level, appear by default based on the course
setup. You can't change these details for a course section.

1. Click the Ownership tab.
2. View the ownership details.

Add Requisites for Course Sections  
When you create a course section, you can add requisites.

Course prerequisites and program requisites that display for the course section are inherited from the course.

Click Override to set up requisites specific to a course section that are distinct from the inherited requisites.

The Description data is also inherited from the course. When you override course prerequisites or program requisites,
you can edit the description.
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Here’s how the override is used when the enrollment engine checks if a student has met a requisite:

• If Override is on, the process uses the section requisites instead of the course requisites.

• If Override is off, the process uses the course requisites.

Requisite Schemes

Add Meeting Information for Course Sections  
When you create course sections, add meeting information such as date and location.

Note:  Before you can create a meeting, you must enter and save at least one course type for the course section. Add
Administrative Data for Course Sections

1. Click the Meeting Information tab.
2. Click Add Meeting.
3. Select a meeting type.

Values are available based on the course types on the course setup.
4. Enter a start and end date.

To create a one-day meeting, take these steps:
a. Select the date of the meeting as the start date. For example, 4/6/2023.
b. Select the date of the next day as the end date. For example, 4/7/2023.
c. Enter the meeting day, such as Thursday.
d. Save the meeting.

The meeting is displayed with a start and end date of 4/6/2023.
5. If relevant, enter a start and end time and a time zone.
6. If you select All Day, the time displays as 12.00AM – 11.59PM.
7. Select the meeting day or days.
8. Click Save.

You're taken back to the Meeting Information landing page where you can view meeting details.
9. To view meeting dates, click the Actions ellipsis and then click Edit Meeting Information.

The individual meeting dates are displayed at the end of the page.
10. To change the meeting dates, edit the start and end dates and click Update.
11. Click Cancel to return to the landing page.
12. To select a building and facility, click Assign Building and Facility or use the ellipsis.
13. Select a building and facility and click Save.
14. To select staff, click Assign Staff or use the ellipsis.
15. Click the staff person's name to add them to the Current Selections box.
16. Click Next.
17. If relevant, update the role type and select a primary instructor.
18. If you select Display on Section, information about the staff person, such as contact details, appears on the

course section in student self-service pages.
19. Click Save.
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Rapid Implementation
You can also create and load course sections using the Rapid Implementation process. Use these tasks in the Setup and
Maintenance work area, Student Management offering:

• Create Curriculum Items Configuration in Spreadsheet

• Upload Curriculum Structures in Spreadsheet

Related Topics
• Rapid Implementation for Oracle Student Management Cloud

Edit Course Sections  
You can update data in one or multiple tabs and save your changes.

Except for the Details tab, updates to multiple tabs are saved independently of each other. Errors on a tab prevent data
on only that tab from being saved.

For example, you update both result types (Administrative Data tab) and descriptive text and save. Descriptive text is
saved even if there’s an error for result types.

Errors on the Details tab prevent the entire record from being saved.

Use the error panel to view and manage multiple errors across fields and tabs. When you edit a course section, the error
panel appears when the first error occurs. Each subsequent error is added to the panel. In the error panel, click View to
go to a particular error.

Copy and Delete Course Sections  
You can copy a course section and use it as a template for creating other course sections with the same type of data.

Access the Course Sections page: From Student Central, click Search and search for Course Sections.

To copy a course section, click the Duplicate icon.

Use the error panel to view and manage multiple errors across fields and tabs. When you copy a course section, the
error panel appears when the first error occurs. Each subsequent error is added to the panel. In the error panel, click
View to go to a particular error.

You can delete a course section. First set the status to Canceled on the Details tab. Add Details for Courses

You can't delete a course section if students are enrolled in it.
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Course Lists  

Features to Set Up Before You Create Course Lists  
Set up these required features before you create course lists.

Feature More Information

Academic Institutions
 

Academic Institutions
 

Campuses
 

Campuses
 

Academic Organizations
 

Academic Organizations
 

Academic Levels
 

Academic Levels
 

Courses
 

Create Courses
 

Before you can configure course list ownership, you must define relationships between entities (system offices,
institutions, campuses, academic organizations).

Create Course Lists  
Create a course list to prescribe a list of courses that satisfy an academic requirement, such as the core requirements for
a major. You use course lists when you create academic groups and programs.

Note:  Before you begin, review the list of features that you must set up before you create course lists. Features to Set
Up Before You Create Course Lists

Here’s how you create a course list:

1. Add details.
2. Assign ownership.
3. Add courses.

Access the Course Lists page: From Student Central, click Search and search for Course Lists.

Add Details
1. Click Create Course List.
2. Enter a name, title, and code.
3. You can enter an optional description.
4. Click Create.
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The data you entered shows in the Details tab.

Note:  When you create a course list, the status is set to Inactive. You must complete all required fields and assign
ownership and academic level before you can set a course list to Active.

Assign Ownership
1. Click the Ownership tab.
2. Click Assign Ownership.

You can assign only one entity type (an academic organization) as the owner.
3. Click the entity.

It appears in the Current Selections box.
4. Click Assign.
5. Click the Actions ellipsis.
6. Click Edit Academic Levels to assign an academic level.

You must assign an academic level when you create a course list.
7. Click Add Row and select an academic level.
8. Click Update.

Add Courses
1. Click the Courses tab.
2. You can add an optional description.
3. Click Add Course Items.
4. Search for courses and course lists and click to select them.

The selections you make appear in the Current Selections box.
5. Click Add to List.
6. To group courses, select the courses and click Create Group.
7. To edit a group name and add or edit a description, click the ellipsis for the group and click Edit Details.
8. You can use various other actions in the ellipsis menu to manage your course list requirements.
9. Click Save.

10. When you're ready, you can set the course list to Active.

Note:  You must complete all required fields and assign ownership and academic level before you can set a course list
to Active.

Rapid Implementation
You can also create and load course lists using the Rapid Implementation process. Use these tasks in the Setup and
Maintenance work area, Student Management offering:

• Create Curriculum Items Configuration in Spreadsheet

• Upload Curriculum Structures in Spreadsheet
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Related Topics
• Requirement Categories

• Rapid Implementation for Oracle Student Management Cloud

Create Academic Groups  
Academic groups are required for building programs. A program is usually owned by an entity such as a college or
faculty. These entities are academic groups.

When you add a program to a student's record, you automatically assign the student to an academic group.

An academic group can also be a container for particular requirements such as college-level requirements. For example,
in addition to a program major, students must complete requirements set by the college, such as general education
units.

Access the Academic Groups page: From Student Central, click Search and search for Manage Curriculum. Then click
Actions.

Structure
In the Academic Group Requirements section, you can enter free-form content, which is available to students in self-
service pages.

When you build your academic structure you can add courses and course lists.

The Requirement Category and Connectors features are works-in-progress and not yet ready to use.

Parameters
You can indicate the minimum and maximum units and number of courses for requirement categories, such as the
maximum number of elective units. You must enter parameters for the predefined Total Units and Courses category,
which displays automatically.

Results
You can add a result type. Only result types associated with the valid curriculum item type (in this case, academic group)
are available. Define result types on the Manage Result Types page.

Rapid Implementation
You can also create and load academic groups using the Rapid Implementation process. Use these tasks in the Setup
and Maintenance work area, Student Management offering:

• Create Curriculum Items Configuration in Spreadsheet

• Upload Curriculum Structures in Spreadsheet
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Related Topics
• Create Programs

• Create Course Lists

• Requirement Categories

• Result Types

• Rapid Implementation for Oracle Student Management Cloud

Programs  

Overview of Programs  
Use the Create Program flow to create programs of study such as a certificate program, a major, or a minor.

To create a program, enter this data:

• Initial setup data such as build status

• Basic information

• Attributes

• Administrative controls

• Descriptive text

• Requirements and parameter

You can also create programs using the Rapid Implementation process. Use these tasks in the Setup and Maintenance
work area, Student Management offering:

• Create Curriculum Items Configuration in Spreadsheet

• Upload Curriculum Structures in Spreadsheet

Related Topics
• Create Programs

• Rapid Implementation for Oracle Student Management Cloud

Create Programs  
Create programs of study such as a certificate program, a major, or a minor.

Access the Programs page: From Student Central, click Search and search for Manage Curriculum.

Before you create programs, create courses, course lists, and academic groups.
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Build Status
Select a build status, such as Open for Admission, from the statuses you defined on the Curriculum Build Statuses
page. When you select a build status, a value of Active or Inactive appears in the Program Status field, based on the
setup mapping. Only active programs are available in the self-service catalog.

Summary and Structure
Continue to create the program using the Summary and Structure tabs. This setup is discussed in other program topics.

Rapid Implementation
You can also create and load programs using the Rapid Implementation process. Use these tasks in the Setup and
Maintenance work area, Student Management offering:

• Create Curriculum Items Configuration in Spreadsheet

• Upload Curriculum Structures in Spreadsheet

Related Topics
• Program Types

• Curriculum Build Statuses

• Display Curriculum Item Images

• Rapid Implementation for Oracle Student Management Cloud

• Control Data Access by Role

Add Basic Information for Programs  
When you create a program, enter information such as program type and campus.

You can add one or more campuses for a program. You can attach an image for the program to display in self-service
pages.

Access the Programs page: From Student Central, click Search and search for Manage Curriculum.

Program Type and Main Program
Whether a program is a main program matters for managing student programs. For example, a student's program
record must always include at least one main program for each academic group.

Here's how it works:

1. When you create a program type, indicate whether the program type is a main program. For example, indicate
that a major is a main program.

2. When you create a program, select a program type. For example, create a Biology program and select major as
the program type. The Biology major is then considered a main program for all downstream processes.

Note:  To ensure that the Academic Planner is available in student self-service, the program must be a main type
program.
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Rapid Implementation
You can also create and load programs using the Rapid Implementation process. Use these tasks in the Setup and
Maintenance work area, Student Management offering:

• Create Curriculum Items Configuration in Spreadsheet

• Upload Curriculum Structures in Spreadsheet

Related Topics
• Overview of Programs

• Rapid Implementation for Oracle Student Management Cloud

• Program Types

Add Attributes for Programs  
When you create a program, add attributes such as academic group and credentials.

Access the Programs page: From Student Central, click Search and search for Manage Curriculum.

Academic Level
Select an academic level for the program. For example, create a Biology major at the Undergraduate level.

Academic Group
Select an academic group for the program. For example create a Biology major in the College of Natural Sciences. In
a student's program record, programs are organized by academic group. To maintain consistency across program
offerings, you can select only an academic group with an academic level that matches the program level.

You can associate a main program with only one academic group. You can associate a program that isn't a main
program with more than one academic group or make it available to all academic groups.

Credentials
You can add one or more credentials for a program. Credentials are degrees, diplomas, or certificates that students can
earn after successful completion of their study. Credentials are recorded on a student's academic record.

The credential formal name is defined using the Credentials page, but you can edit the name when you add a credential
to a program. For example, if the formal name is Bachelor of Arts, you might change it to Bachelor of Arts in History
when you add the credential to a History program.

Sometimes, credentials are awarded to students as they proceed through their program of study as well as on
completion of the program. For multiple credentials, you must select at least one final credential to indicate that a
student completes the program when the student achieves this credential. You can add more than one final credential
to a program, such as Bachelor of Arts and Bachelor of Science. For programs with multiple credentials, use the Display
Sequence field to order credentials. This order is used in credential search and summary pages.
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Rapid Implementation
You can also create and load programs using the Rapid Implementation process. Use these tasks in the Setup and
Maintenance work area, Student Management offering:

• Create Curriculum Items Configuration in Spreadsheet

• Upload Curriculum Structures in Spreadsheet

Related Topics
• Create Academic Groups

• Add Basic Information for Programs

• Academic Levels

• Academic Credentials

Add Administrative Controls for Programs  
When you create a program, add administrative controls such as whether admission is required and how programs
display in self-service pages.

Access the Programs page: From Student Central, click Search and search for Manage Curriculum.

Select Available in search and Allow save to wish list to indicate that guests and students can search for a program
and add it to their wish list from self-service pages.

Use the Student Level Determination field to determine a student's level within a program, based on the student's
total number of completed and enrolled units. Student level and load are calculated based on enrollment units. Statistics
are stored on the Student Results page. To ensure level and load calculation occurs, you must also create level and load
result sets and attach them to result types. Use the Manage Result Sets and Manage Result Types pages.

Different enrollment models have different enrollment and payment processes. For example, Continuing Education
students might pay before they enroll in a course, using a typical internet shopping cart experience. For institutions that
use a traditional enrollment model in which students plan their courses based on program requirements, students might
enroll in courses first and be billed later. Select an enrollment mode of Shopping cart or Scheduler and a payment
mode of Pay to enroll or Bill later. These fields are available and required only for main programs. Use the Program
Types page to indicate main programs.

Note:  To ensure that the Academic Planner is available in student self-service, select an enrollment mode of
Scheduler for a main type program.

Admission Controls
Indicate how students are admitted to a program.

Select the Admission required check box to identify a program as one to which students must be admitted before they
begin study.
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In Self-Service, a student applying to a traditional program can click the Apply button to submit an online application if
these things are true:

• In the program setup, the program is a main program (based on program type) and the Admission required
check box is selected.

• In Admissions Form Inventory, a form is published for the program.

Select the Auto admit check box to identify a program as one to which students can be automatically admitted when
they submit a simple application. For example, a Continuing Education program might not have formal admission
requirements such as proof of a high school diploma or completion of a bachelor's degree.

In Self-Service, a Continuing Education student can click the Apply button to submit a simple online application and be
automatically admitted to a program if these things are true:

• In the program setup, the program is a main program (based on program type) and the Auto admit check box
is selected.

• In Admissions Form Inventory, a form is published for the program.

Learning Packages
You can set up a program so that students pay a flat fee for the program and then enroll in the courses that belong to
the program. Students don't pay for individual courses.

Complete these steps:

1. Select the Admission required check box.
2. Select the Pay to access check box.

◦ In the Enrollment Mode field, Shopping cart is automatically selected and you can't edit the field.

◦ In the Payment Mode field, Pay to enroll is automatically selected and you can't edit the field.

3. Add a fee for the program.

Tags
Add curriculum tags to programs to influence what happens in self-service pages:

• You must add an Area of Study tag and value such as Art or Business to a program to ensure that guests and
students can browse for the program. Programs are listed by area of study in the catalog.

• You must add a Featured Catalog tag and value to a program to ensure the program displays in categories
such as New or Popular on the guest and student home page.

If you don't add curriculum tags, guests and students can search for programs, but using only the keyword search.

Add the Group Manager Eligible tag and select Yes to indicate that a group manager can apply to this program on
behalf of a student.

Staff
You can add staff for the program.

• Staff are available based on the Manage Academic Staff setup.

• Role access:
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◦ Select Grader to identify staff members who can access the grade roster and post grades.

◦ Point of contact information is used on externally facing user interfaces such as browse catalog.

• Select the Primary check box to indicate the primary person for the program.

• If you select the Back Office Only check box, information about the staff person, such as contact details,
doesn't appear in student self-service pages.

Rapid Implementation
You can also create and load programs using the Rapid Implementation process. Use these tasks in the Setup and
Maintenance work area, Student Management offering:

• Create Curriculum Items Configuration in Spreadsheet

• Upload Curriculum Structures in Spreadsheet

Related Topics
• Overview of Programs

• Enable Program Application by Group Manager

• Curriculum Tags

• Rapid Implementation for Oracle Student Management Cloud

Create a Program Structure  
When you create a program, add requirements and parameters to create a program structure.

Access the Programs page: From Student Central, click Search and search for Manage Curriculum.

Requirements
In the Program Requirements section, you can enter free-form content, which is available to students in self-service
pages.

When you build your program structure you can add courses and course lists. For example, you might add a course list
for a major or minor.

The Requirement Category and Connectors features are works-in-progress and not yet ready to use.

Parameters
You can indicate the minimum and maximum units and number of courses for requirement categories, such as the
maximum number of elective units. You must enter parameters for the predefined Total Units and Courses category,
which displays automatically.

Rapid Implementation
You can also create and load programs using the Rapid Implementation process. Use these tasks in the Setup and
Maintenance work area, Student Management offering:

• Create Curriculum Items Configuration in Spreadsheet
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• Upload Curriculum Structures in Spreadsheet

Related Topics
• Overview of Programs

• Create Course Lists

• Requirement Categories

• Rapid Implementation for Oracle Student Management Cloud

Edit Programs  
After you create and save a program, you can edit the program in various ways. For example you can create a new
version of the program.

Access the Programs page: From Student Central, click Search and search for Manage Curriculum.

When you access an existing program, the page opens in view mode. Here are the actions you can take:

• Insert Record

• Correct Record

• Delete Record

• End Date

Insert Record
Select this action to create a new version of an existing program.

Usually, you use the Insert Record action for a change that will be effective in the future, such as different program
requirements for an academic year. You can change the effective date to any date later than the date of the existing
maximum effective dated row.

In rare cases, you might insert a row between two existing rows to correctly represent the history of the program, such
as after conversion. If you insert a new record between two existing rows, you can change the effective date of the new
row. The effective date for the new row must meet both these criteria:

• Be earlier than the effective date of the row above (if a row exists).

• Be later than the effective date of the row below.

Correct Record
Select this action to edit an existing program row.

To edit the effective date and the data for the row:

1. Edit the effective date: Click the edit icon to access the Edit Program Effective Date page. If multiple effective
dated rows exist, the effective date that you enter for the edited row must meet both these criteria:

◦ Be earlier than the effective date of the row above (if a row exists).

◦ Be later than the effective date of the row below.
2. Edit the program data. When you select the Correct Record action, the various sections of the page such as

Attributes and Administrative Controls become available for editing.
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Delete Record
Select this action to delete an existing program row.

End Date
Select this action to end a program.

The End Date action is available only on the maximum effective dated row for the program. Select the action and enter
an end date for the program. After you end a program, actions are available for the program, but with some restrictions:

• Insert Record: The effective date of the new row must be earlier than or the same as the program end date.

• Correct Record: The effective date of the maximum effective dated row must be earlier than the program end
date.

• Delete Record: No restrictions.

• End Date: Remains restricted to the maximum effective dated row (a user can update the program end date).

Manage Enrollment Communications  
Manage your communication with students when particular enrollment events occur. For example, you can send a
confirmation email to a student when the student enrolls in or drops a course.

Here's what you must do before you can create communications:

1. Create a Student Management Category to be used for particular predefined events.
2. Map the events such as Enrollment Add or Enrollment Drop to the category.

Then, when you create a communication, you select that category and event to trigger the communication.

Related Topics
• Overview of Communications

• Communication Categories

• Create a Communication
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8  Learners

Overview of Student Programs Management  
You can respond to students' requests regarding their programs. For example, pause a student's program when the
student is granted a leave of absence.

You can also initiate actions for student programs. For example, update a student's program record to indicate that the
student has completed the program.

Use the Learners work area to manage student programs:

• Add programs

• Set a primary program

• Pause programs

• Switch programs

• End programs

• Complete programs

• Delete programs

Before you begin, review these key elements of program setup:

• Program types

• Main programs

• The relationship between programs and academic groups

Keep in mind that for each academic group on a student's record, the student must have at least one main program.
Indicate main programs when you create program types.

Related Topics
• Add Attributes for Programs

• Add Basic Information for Programs

• Create Academic Groups

• Program Types

Add Student Programs  
You can add programs to a student's record. For example, add a program for a Continuing Education student when the
program doesn't require an admissions process.

Or for a traditional institution, add a program when a student wants to change programs and the new program belongs
to a different academic group. In this case, end the existing program and add the new program.

1. From Student Central, click Search and search for Learners.
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2. Search for the student.
3. Click Programs.
4. Click Add Program.
5. Search for the program and click Next.
6. Enter the program details and click Save.

Use the Requirement Period field when a student follows a different version of program requirements than the version
associated with the student's admit term. The Requirement Period value influences what the student sees in the
academic planner. For example, based on new academic requirements, students who begin a program in Fall 2019 must
complete more units than students in the previous version of the program. A student who was admitted in Fall 2018, but
deferred until Fall 2019 due to personal circumstances, is approved to follow Fall 2018 requirements. Here's the data in
the student's program record:

• The admit term is Fall 2019.

• The requirement term is Fall 2018.

Things to Keep in Mind
Here are some things to keep in mind.

• When you add a program to a student's record, the related academic group is automatically added. A college is
an example of an academic group.

• A student must have at least one main program per academic group. A major is an example of a main program.
You indicate main programs when you create program types.

• When you set up programs, you can associate a program with an academic group in these ways:

◦ A main program with only one group.

◦ A program that isn't a main program with one or more groups or with all groups.

What Happens When You Add Programs for Students
Which programs you can search for and which academic group a program is added to depends on whether you're
adding the first program or a later one.

Here's what happens when you add the first program:

• When you search for the program, the search returns only main programs.

• When you add the program and save, the relevant academic group is automatically added to the student's
record.

Here's what happens when you add a program after you've added the first program:

• You can search for main programs and programs that aren't main ones.

• For the student's existing group, you can add main programs or add programs that aren't main ones.

• For a new group, the first program you add must be a main program.

• You can add a program that's valid for all groups:

◦ If the student has one group, the program is automatically assigned to that group.

◦ If the student has more than one group, the program is automatically assigned to the first (earliest) group
on the student's record. You can select a different group for the program.
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Related Topics
• Create Academic Groups

• Add Basic Information for Programs

• Add Attributes for Programs

Set a Primary Student Program  
When a student has multiple programs at the same academic level, identify a primary program for downstream
processes such as tuition calculation.You can set only a main program as primary.

Primary program is based on academic level. A student's programs are organized by academic group. Programs at the
same level can belong to different groups. For example, a student has two Undergraduate majors, one in the College of
Natural Sciences and one in the College of Liberal Arts. Set one major as the primary program.

To set a primary program:

1. From Student Central, click Search and search for Learners.
2. Search for the student.
3. Click Programs.
4. On the Student Programs page, click Set Primary.
5. On the Set Primary Program page, review the (main) programs which are listed by academic level.
6. Select a primary program.
7. Enter the date when the program becomes primary. You can make the program primary for a future date.
8. Click Save.

Related Topics
• Add Attributes for Programs

• Create Academic Groups

• Program Types

Pause and Resume Student Programs  
Pause a student's program for a period of time when the student takes a leave of absence from study. You can resume
the program when the student returns to study.

Pause Programs
A pause applies to the student's academic group and all programs within that group. You take the pause action for the
academic group.

1. From Student Central, click Search and search for Learners.
2. Search for the student.
3. Click Programs.
4. On the Student Programs page, select Pause Programs for the academic group.
5. On the Pause Programs page, enter the relevant data and click Save.
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Resume Programs
The Pause Programs action remains available for the academic group. Use this same action to edit the pause details or
to resume the group and related programs.

1. On the Student Programs page, select Pause Programs for the academic group.
2. On the Resume Programs page, enter the relevant data. You can enter a resume date that's before the pause

end date if the student resumes study earlier than expected.
3. Click Save.

Related Topics
• Create Academic Groups

• Add Attributes for Programs

Switch Student Programs  
Switch programs for a student who wants to change from one program to another. For example, a student changes
from a Biology major to a Chemistry major.

You can switch programs for a student only if the new program is the same as the existing program in these ways:

• Institution

• Program type

• Academic level

• Academic group

If a student wants to change to a program in a different academic group for example, you need to discontinue the
existing group (and all programs within the group) and add the new group and program combination.

To switch programs:

1. From Student Central, click Search and search for Learners.
2. Search for the student.
3. Click Programs.
4. On the Student Programs page, select Switch Programs for the program the student wants to switch from.
5. On the Search Programs page, search for the program to switch to.

The search returns only programs that meet the switch criteria explained previously.
6. Select the program to switch to.
7. Click Next.
8. Enter the relevant data on the Switch Programs page and click Save.

Related Topics
• Add Attributes for Programs

• Create Academic Groups

• Add Basic Information for Programs

• Add Student Programs

• End Student Programs

62



Oracle Fusion Cloud Student Management
Using Student Management

Chapter 8
Learners

Complete Student Programs  
When a student finishes a program of study, update the student's record to indicate program completion.

Here's some key information about completing programs.

• You can complete any type of program. For example, complete a major or a minor.

• You can complete a program regardless of whether the program has credentials associated with it.

• You can complete a program regardless of whether the student has been awarded a final credential for the
program.

To complete a program:

1. From Student Central, click Search and search for Learners.
2. Search for the student.
3. Click Programs.
4. On the Student Programs page, select Complete Program for the particular program.
5. On the Complete Program page, enter a completion date. You can also enter other information such as notes

about the completion.
6. Click Submit.

For a completed program, select Edit Details and click Remove Completion to reverse the completion and return the
program to an active status.

Related Topics
• Academic Credentials

End Student Programs  
End a student's program when the student no longer wants to study the program.

You can't end a program if the student has been awarded a credential for the program.

To end a program, use the Student Programs page in the Learners work area. From Student Central, click Search and
search for Learners. Whether you take the end action at the program or academic group level depends on the particular
student's program record. Keep in mind that a student must always have at least one main program for each academic
group. Let's look at some scenarios using these assumptions:

• A major is a main program and a minor isn't.

• A college is an academic group.

Student's Programs Program Action or Academic Group Action?

A French major and a German major in the
College of Liberal Arts.
 
Student wants to stop studying French.

Program action: For the French program, select End Major.
 
The student still has one main program in the academic group.
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Student's Programs Program Action or Academic Group Action?

 

A Biology major and a Chemistry minor in
the College of Natural Sciences.
 
Student wants to stop studying Chemistry.
 

Program action: For the Chemistry program, select End Minor.
 
The student still has one main program in the academic group.
 

A Biology major and a Chemistry minor in
the College of Natural Sciences.
 
Student wants to withdraw from all study.
 

Academic group action: For College of Natural Sciences group, select Discontinue All.
 

A French major in the College of Liberal
Arts.
 
Student wants to stop studying French.
 

Academic group action: For the College of Liberal Arts group, select Discontinue All.
 
The student must have at least one main program per academic group. Because the French major is
the only program in the group, the action is available at the group level.
 

A Biology major and a Chemistry minor in
the College of Natural Sciences.
 
Student wants to stop studying Biology
but keep studying Chemistry.
 

You can't end the Biology major because the student must have at least one main program per
academic group. The student could request to switch from Biology to a different major (main program).
 

Related Topics
• Create Academic Groups

• Add Basic Information for Programs

• Add Attributes for Programs

• Academic Credentials

Delete Student Programs  
You can delete a program from a student's record to correct the record when a program was added in error.

If a program meets any of these criteria, you can't delete it:

• The student has been awarded a credential for the program.

• Program history exists. For example, the student was in program A in one academic year and switched to
program B in the next academic year. You can't delete program B because of the program change history.

• Pause history exists. If a program is paused, a history is maintained that prevents deletion.

If you delete the sole (main) program in an academic group, the group is automatically deleted.

To delete a student's program:

1. From Student Central, click Search and search for Learners.
2. Search for the student.
3. Click Programs.
4. On the Student Programs page, select Delete Program for the program.
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5. Click Yes to delete the program.

Related Topics
• Create Academic Groups

• Add Basic Information for Programs

• Add Attributes for Programs

• Pause and Resume Student Programs

Overview of Student Enrollment Management  
You can add and drop scheduled courses for an individual student or a cohort of students.

For example, override an enrollment validation such as a prerequisite to add a course to a student's record. Or drop a
course for multiple students when a course is canceled. You can also review and track student enrollment history.

To manage enrollment for individual students, use the Learners work area. To manage enrollment for multiple students,
use the Scheduled Processes work area.

A scheduled course is also known as a course section.

Add Scheduled Courses  
You can add scheduled courses to a student's record. For example, a student is approved to study a course even though
the student hasn't met the prerequisite. Add the course for the student by overriding the prerequisite enrollment
validation.

You can also add a scheduled course for multiple students at the same time.

A scheduled course is also known as a course section.

Add Scheduled Courses for a Student
To add a scheduled course for a student:

1. From Student Central, click Search and search for Learners.
2. Search for the student.
3. Click Enrollment.
4. On the Student Enrollment page, click Add Scheduled Courses.
5. Search for the course.
6. Click Add to Cart for the course.
7. Click Continue.
8. On the Add Scheduled Courses page, you can select various enrollment options:

◦ Select a unit value, such as 3 units or 4 units, if the course has variable units.

A variable unit course is one in which the number of units varies based on the amount of work a student
is required to complete.
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◦ Select an academic level if the student has academic groups at multiple academic levels. For example, a
student has a graduate level group and an undergraduate level group.

◦ Override enrollment validations such as enrollment limits or prerequisites.

9. Click Process.

Add Scheduled Courses for Multiple Students
To add a scheduled course for multiple students at the same time:

1. Click Navigator and in the Tools area, click Scheduled Processes.
2. Click Schedule New Process.
3. Select Add Student Course Enrollments and click OK.
4. Select a Population Selection query to identify the students and click OK.
5. Click Add Scheduled Courses and select the course or courses.

You can run the process for multiple scheduled courses at the same time.
6. Click Submit.

Related Topics
• Add a Student to a Waitlist

• Academic Levels

Add a Student to a Waitlist  
You can add a student to a waitlist for a scheduled course.

A scheduled course is also known as a course section.

Whether you can add a student to a waitlist depends on the course setup and waitlist security permissions.

When you create and schedule a course, you can enter a waitlist capacity. Here's what happens when enrollment in the
scheduled course is full:

• The status of the scheduled course changes to Waitlist Available.

• On the Add Scheduled Courses page, the Waitlist check box is available.

To add a student to a waitlist:

1. Follow the steps Add Scheduled Courses to add a scheduled course to the student's record.
2. At step 8, select the Waitlist check box on the Add Scheduled Courses page.
3. Click Process:

◦ The student's enrollment status is set to Waitlisted.

◦ The student is assigned a position number on the waitlist.

You can notify students when they're added to a waitlist.
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Related Topics
• Rosters Management

• Manage Access to Waitlist Information

• Overview of Communications

Drop Scheduled Courses  
You can drop scheduled courses from a student's record. For example, when the drop deadline has passed, drop a
course for a student by overriding the deadline enrollment validation.

You can also drop a scheduled course for multiple students at the same time. For example, when a school cancels a
course due to low enrollment, drop the course for all enrolled students.

A scheduled course is also known as a course section.

Drop Scheduled Courses for a Student
To drop a scheduled course for a student:

1. From Student Central, click Search and search for Learners.
2. Search for the student.
3. Click Enrollment.
4. On the Student Enrollment page, select the scheduled course and click Drop.
5. You can indicate whether the student attended the course, the last date of attendance, and a drop reason.
6. You can override enrollment validations such as drop deadlines.
7. Click Process.

Drop Scheduled Courses for Multiple Students
To drop scheduled courses for multiple students:

1. Click Navigator and in the Tools area, click Scheduled Processes.
2. Click Schedule New Process.
3. Select Drop Student Course Enrollments and click OK.
4. Select a Population Selection query to identify the students and click OK.
5. Click Submit.

Drop Processing
Drop processing is influenced by both these factors:

• The drop scheme setup.

• The period attribute dates for the academic period that's selected for the course section. Or the dates defined
on the course section, if the period dates are overridden.

Here's what happens when you drop a scheduled course from a student's record:
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Drop Deadline Student's Record

Last Date to Drop: Do Not Retain
 

The course enrollment status is changed to Deleted. Courses with this status don't appear in the
student facing UI or the administrative enrollment and roster UIs.
 

Last Date to Drop: Retain
 

The course is retained on the student's enrollment record with an enrollment status of Dropped.
 

Dropped: Penalty Result
 

The course is retained on the student's enrollment record with an enrollment status of Withdrawn.
If the drop scheme setup includes penalty grades, a grade such as W (Withdrawal) shows on the
student's record.
 

Last Date to Drop: Greater Penalty
 

The course is retained on the student's enrollment record with an enrollment status of Withdrawn. If
the drop scheme setup includes penalty grades, a grade such as WF (Withdrawal: Fail) shows on the
student's record.
 

Related Topics
• Drop Schemes

• Enrollment Action Reasons

Evaluate Student Requisites  
Evaluate student requisites to potentially drop students from course sections when they haven't satisfied required
prerequisite courses.

Use the Evaluate Student Requisites process for post enrollment prerequisite verification.

Here’s what the process does for courses in a particular academic period:

• Evaluates the records of students enrolled in the course to check if students have met the course prerequisites.

• Identifies which students haven’t met the prerequisites.

• Removes students from the course.

The process uses course outcomes only, not result set values.

Here’s how you run the process:

1. Click Navigator and in the Tools area, click Scheduled Processes.
2. Click Schedule New Process.
3. Select Evaluate Student Requisites and click OK.
4. Select your parameters.
5. Click Submit.

Drop Enrollments Process Mode
To notify students that they've been dropped from a course, create a communication category for the delivered
Enrollment Drop event. Then create the email communication.
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Notify Only Process Mode
To warn students that they will be dropped from a course, select the Notify Only process mode. To notify students,
create a communication category for the delivered Process Student Requisites Warnings event. Then create the email
communication.

Related Topics
• Requisite Schemes

• Communication Categories

• Create a Communication

Manage Student Results  
Calculate and manage statistics and results for students.

From Student Central, click Search and search for Learners. Search for the student and click Student Results.

Prerequisite
In result type setup, make sure that you map each student statistics result type to a valid result set.

Period Statistics
Academic statistics are calculated for students with an active academic program who enroll in courses where the result
set (grading option such as Letter Grade, Pass or Fail) attached to the course can earn credit. Here we discuss period
statistics. Cumulative statistics are calculated and stored in a similar way.

Let's look at the key fields on the Period Statistics tab to understand how a student's statistics are calculated and stored
for a reporting period.

• No GPA Units Attempted: The total number of units attempted where the units don't contribute to the grade
point average.

• No GPA Units Earned: The total number of units earned where the units don't contribute to the grade point
average.

• GPA Units Attempted: The total number of units attempted where the units contribute to the grade point
average.

• GPA Units Earned: The total number of units earned where the units contribute to the grade point average.

• Grade Points: The total number of grade points.

• Total In-Progress Units: The total number of units enrolled in, where no final result has been posted.

• Total Earned Units: The total number of units earned.

• Grade Point Average: The grade point average, stored at the reporting period level.

Recalculate Statistics
Use the Recalculate Student Academic Statistics process to recalculate student statistics data.

69

https://www.oracle.com/pls/topic/lookup?ctx=fa24c&id=s20065061
https://www.oracle.com/pls/topic/lookup?ctx=fa24c&id=s20068362
https://www.oracle.com/pls/topic/lookup?ctx=fa24c&id=s20068423


Oracle Fusion Cloud Student Management
Using Student Management

Chapter 8
Learners

Click Navigator > Tools > Scheduled Processes > Schedule New Process. You can recalculate statistics for one or all
students.

Related Topics
• Result Sets

• Result Types

Manage Student Credentials  
You can award credentials when a student completes a program. For example, award a final credential such as a degree.
You can also award a credential, such as a certificate, during a student's progress toward a final credential.

From Student Central, click Search and search for Learners. Search for the student and click Student Credentials.

You can manage student credentials in these ways:

• Add or edit a credential.

• View credential history.

• Delete a credential that was added in error.

• Revoke a credential. You might use the revoke action in the case of student plagiarism.

Manage Student Test Result  
Record standardized test results for students. Enter the component score results for each test and record different test
attempts by test date.

Student Test Results, a central place where you view and maintain test results received for an applicant or student. It
even shows test data received for the same test, but taken on different dates. Also, it clearly shows whether the scores
are considered official or self-reported. Additionally, a student can view their own test results from self-service.

To go to the Student Test Results landing page, from Student Central, click Search and search for Student Test Results.

Here are some things you can do on this page:

• Search for a student test details using student name, email, or constituent id or use advanced search to search
by test name, date range, and so on. You can further narrow down the search results using the filters.

• Select an existing test and add component score results, or add new test details and components.

• Using self-service, your student can view their own test results.

Here is how to add a new test for a student:

1. From Student Central, click Search and search for Student Test Results.
2. Select the student you want to add a test for.
3. Click Add Test.
4. Specify the required details, such as Date, Name, and so on, then click Next.
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5. Enter test score details, then click Add.
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9  Rosters

Rosters Management  
You can use rosters to view and manage student enrollment and results data.

From Student Central, click Search and search for Rosters.

A scheduled course is also known as a course section.

Access to Rosters
Here are some key points about access to rosters:

1. If you have the relevant security profile, you can access the Rosters UI.
2. On the Rosters landing page, you can access rosters only for the scheduled courses to which you're assigned as

a staff member.
Staff are assigned to a scheduled course (in the Instructional Staff section) when a course is created and
scheduled.

3. There's one exception. If your security profile includes the Registrar role, you can access rosters for all
scheduled courses.

Scheduled Course Rosters
You can view this information:

• Students enrolled in the scheduled course.

• Staff associated with the scheduled course.

On the Waitlist tab, which information you can see and which actions you can take depends on security permissions.

You can notify students when they're added to, removed from, or enrolled from a waitlist and when their position on a
waitlist changes.

Grade Rosters
Here are some things that you can do:

• View, edit, or remove grades for students in a scheduled course.

• Add notes to a student's result records.

• Access a student's result history.

Related Topics
• Add a Student to a Waitlist

• Manage Access to Waitlist Information

• Overview of Communications
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10  Finances

Overview of Finances  
The Finances work area is where you manage student tuition, fees, and credits such as external funds and
sponsorships. You can generate bills and issue refunds as well as manage student's and organization's financial
accounts.

To access the Finances work area, from Student Central search for Student Finances. Alternatively, from Home, click
Navigator > Academics > Finances .

Here are some things that you can do:

• Set up and maintain academic business units.

• Set up and calculate fees and tuition.

• Maintain due date and adjustment calendars.

• Manage student and sponsoring organization accounts.

• Manage credits and sponsorship.

• Manage bills and payments.

• Manage refunds.

From the landing page, you can look up students and sponsoring organizations. Click on the name of the student or
organization to view summaries of their accounts.

For more information, see:

• Manage Student Accounts

• Manage Organization Transactions

Manage Academic Business Unit  
An academic business unit is a financial entity that you map to an Oracle Fusion Cloud Financials business unit. The
academic business unit contains the underlying financial settings that support the institution's financial transactions.
These settings include selecting a payment method, refund method, or allowing discounts.

Oracle Fusion Cloud Student Management integrates with Financials to carry out processes like accounts payable and
receivables. So when you set up an academic business unit, you map it to a Financials business unit. This association
lets you keep track of financial transactions and, in the future, will let you administer various rules to match the unique
needs of your organizations, campuses, and students.

To manage academic business units, you must have an implementer or administrator role.

As an implementor, in the Setup and Maintenance work area, use the Manage Student Financials Options task:

• Offering: Student Management

• Functional Area: Student Structures
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As an administrator, from Student Central search for   Academic Business Unit .

Currently, you won’t be able to create more than one academic business unit. If you have existing setup, this will be
converted to use the new structure.

From the landing page, if you already created your business unit, click its name to edit the settings associated with it.

Details
From this page, you can set the transaction numbering scheme, enable discounts at the academic business unit level,
and map student financial transactions to accounts receivable values.

Here are some fields to note. The information you provide in the Accounts Receivables Values section is used to create
customer accounts.

• The Auto Numbering scheme you select dictates how transactions and receipts are numbered and whether
you can use your own prefix.

We recommend selecting Student Financials so that you can define your own prefix. The prefix helps you
identify transactions that originate from Student Management. This keeps transactions easier to distinguish
from those of Oracle Fusion Cloud Receivables.

Once you set the auto numbering scheme and prefix, don't change the values. Doing so may impact your
reports and other financial components.

• Select Allow Discount to to enable discounts on tuition and fees at the business unit level. To administer
discounts, go to the Manage Discounts page.

• In Customer Profile Class, select ORA_HED_BFB. This is a seeded profile that includes the necessary settings
to create customer accounts and enable balance forward billing.

• Payment Term is automatically populated with the value that's set up in the profile class you selected.

• In Customer Class, select a value that matches your organization's requirement. The value you select places
users in that group. Think of customer class as a grouping of people.

Transaction Source
In Transaction Source, you can map a fee type to a transaction source. When you create student fees, the mapping on
this page is used to determine which transaction source maps to a fee type and vice versa.

The Default column refers to the default transaction source. You set up transaction sources in Financials, which you
would have already done prior to setting up your academic business unit. See Manage Transaction Sources.

Payments
Payment methods define the ways students can pay for courses or for items associated with these courses. You can
choose to enable one or all payment methods.

You need to select a receipt method for each payment method so you can process the payment and issue receipts.
Receipt methods are defined in Financials. See Manage Receipt Classes and Methods.

For electronic payments, choose either one of these options:

• Oracle payment solution indicates that you want to use Financials as your payment service provider. Make
sure you set up Financials appropriately. See Overview of Financials Implementation for Student Management.
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• Other payment service provider indicates that you want to use your preferred payment service provider. To
use this, you need to integrate your payment service provider with Student Management. See Integrate a Third-
Party Payment Service Provider.

In Payment Error Resolution, it's important that you designate a person who's in charge of resolving payment issues.
This person will receive email notifications about transactions where invoices or receipts couldn't be created. If these
items can't be created, then they aren't recorded in students' accounts. Sending a notification about these issues
informs the designated person that they need to take steps to correct the issue.

Refunds
Refund methods define the ways in which you can refund students or organizations. The methods you set up are what's
available to you whether you manually issue refunds for individuals or multiple recipients.

For each method you create, you can also enable Allow Refunds with Debit Balance. Enable this if you want to put an
account in a debit balance—the account will have outstanding charges after the refund payment is made. The refunding
process will refund the unapplied amount of the receipt for accounts that have both unpaid charges and unapplied
receipts.

Related Topics
• Manage Refunds

• Student Fees

Student Financials Academic Periods  
Student Financials academic periods are used with miscellaneous fees.

To create or view Student Financials academic periods, you can access the relevant task depending on your role.

• As an implementor, in the Setup and Maintenance work area use the Manage Student Financials Academic
Periods task:

◦ Offering: Student Management

◦ Functional Area: Student Structures

• As an administrator, from the Finances work area click Actions > Manage Student Financials Academic
Periods.

For more information on academic periods, see Overview of Academic Periods.

Fees and Calendars  

Overview of Student Fees  
Student fees describe the collection of all amounts that your institution can charge a student.

Examples of student fees include:

• Curriculum fees. These are amounts charged to students for courses and programs.
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• Academic period fees. These are amounts that are calculated based on the billing units of courses that students
are enrolled in for a specific reporting academic period.

• Miscellaneous fees. These are any charges not associated directly with tuition.

Manage Curriculum Fees  
Curriculum fees are fees for courses, scheduled courses, and programs. You can link these fees to items in the
curriculum registry as well as apply them to learning packages. Learning packages are programs with flat fees.

A scheduled course is also known as a course section.

To access the page, from the Finances work area click Actions > Manage Curriculum Fee. Besides course fees and
scheduled course fees, you can also create program fees.

When creating program fees, take note of these fields:

• Use Fee Name to associate the fee with a program. Programs with flat fees must be set up appropriately.

• Select a Transaction Source to indicate the origin of the transaction. You can use these seeded sources: HES
Administrative and HES Administrative Curriculum. Or use the transaction sources you created when you set up
Oracle Fusion Cloud Financials.

• Allow Discount is enabled only when you allow discounts at the academic business unit level.

• External Fund Eligibility is reserved for future use.

• In Academic Period, only reporting academic periods appear on the list.

Related Topics
• Add Administrative Controls for Programs

Manage Academic Period Fees  
An academic period fee is tuition that's calculated based on the billing units of courses that students are enrolled in for a
specific reporting academic period.

To access the page, from the Finances work area click Actions > Manage Academic Period Fees.

You can create, review, and update academic period fees, and review, sort, and filter them. Click Create Academic
Period Fee to create an academic period fee, academic period course fee, or academic period scheduled course fee. You
can show or hide academic period attributes, including the amount charged per range of units.

A scheduled course is also known as a course section.

Manage Sponsorship Fees  
A sponsorship fee is one of the items that make up a sponsorship. You need to create one before you can create a
sponsorship agreement.

To access the page, from Student Central search for Fees.
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When you're creating a fee, take note of these fields:

• In Due Date, assign a due date calendar. This calendar identifies the date when the fee is charged.

• In Academic Period, add the academic period to which the fee is applicable. If you need to add other academic
periods, click Create Attribute to add another row.

Make sure that the sponsorship credit also uses the academic period used in the fee.

• When the fee is charged for the academic period, the fee is identified against the Transaction Type you specify.

• When the charge for the fee is credited, the fee is identified against the Credit Transaction Type you specify.
The values you can choose from are defined in Oracle Fusion Cloud Financials.

Manage Miscellaneous Fees  
Miscellaneous fees can be application fees, general fees, or other fees for charges not directly associated with tuition. So
it can also be admissions application fees, facility rental, or course supplies.

You may need to charge students with fees that aren't tuition-related. You can use miscellaneous fees for that purpose.
Currently, we support:

• Application fee

• General fee

• Miscellaneous fee

To access the page, from the Finances work area  click Actions > Manage Miscellaneous Fees.

When you're creating a fee, take note of these fields:

• In Type, select the type of fee you want to create.

• In Transaction Source, select the receivables transaction source you want to associate with the application fee.

• Selecting Allow discount indicates you're allowing discounts to be applied to the fee. This check box only
appears when you create miscellaneous and application fees.

• In Due Date, select the appropriate due date schedule to determine the due date of the fee.

• In Start Date, set the date when the fee becomes active.

For an application fee, you can use the start and end dates to specify different fee amounts in the same application fee.
For example, you can add an amount with only a start date. In another row, you can add an amount with a different start
date and an end date.

What to do next
If you created an application fee and want to apply it to a program, you need to link the application fee to the program.
See Manage Fee Associations.

Manage Fee Associations  
To charge an application fee, you need to link the fee to the program. You might also want to set up postprocessing
options to indicate how you want to handle applications if there are issues posting payment to students’ accounts.

79



Oracle Fusion Cloud Student Management
Using Student Management

Chapter 10
Finances

Before you start, make sure you've already created an application fee.

1. To access the page, from Student Central search for   Fees , then click  Fee Associations .
2. Click Create Fee Association to link an application fee to a program, or click an existing fee association to edit

it.
When creating a fee association, take note of these fields:

◦ Postprocessing Options indicates what you would like the process to do once an application is
submitted. We recommend you select Always complete to prevent students or applicants from making
multiple payments when there are issues posting transactions to their accounts.
Note that you still have to manually reconcile all transactions that aren't successfully created. And
you would have to notify the student and administrator when there are issues posting transactions to
students' accounts.

◦ In Fee Name, select the application fee you created in Miscellaneous Fees.

◦ Select the Academic Level and Academic Group that the application fee applies to. Anyone applying to
the program must complete the application form and pay the application fee.

A successful payment is required for an application to be considered submitted. This is why we recommend you select
the postprocessing option to always complete so that applications are assigned a submitted status even if there are
issues with posting payments to an applicant’s account. Otherwise, if payment fails, the application remains in “In
Progress” status until payment is successful.

What to do next

You may need to set up notifications to inform administrators and students when transactions fail to post to student
accounts. See Create Notifications About Payment Issues.

Manage Discounts  
Discounts control the percentage and availability of fee reductions. An example is a discount for early enrollment. On
the Manage Academic Business Unit page, select Allow Discount to allow your academic business unit to use discounts.

To access the page, from Student Central search for   Discounts .

From this page, you can:

• Review, sort, and filter discounts; duplicate an existing one, or create a new discount.

• Set a priority order for when to apply discounts.

• Allow bursars to override a discount when creating curriculum fee invoices.

Manage Miscellaneous Categories  
Fee categories are groups of general and miscellaneous fees.

To access the page, from the Finances work area  click Actions > Manage Miscellaneous Categories.

You can set up miscellaneous categories for each institution. Examples of categories are fees related to insurance,
fitness, or parking. You can also group these fees and display them in self-service. The categories you set up appear to
students in self-service on the Review Cart page; students can add these optional items to their cart.
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Manage Fee Groups  
Use fee groups to create a collection of fees that you can use for processes like tuition calculation or payment
application.

To use fee groups to facilitate automatic payment processing, you need to associate the fee group to a charge priority
mapping record, and this mapping record needs to be associated to a student credit.

To access the page, from Student Central search for   Fee Groups .

Before creating a group, note that:

• Fees must already be set up.

• Once you save the fee group, you can't change the group type. If you need to change the group type, delete the
group and start over.

You will want to assign a fee group to be used in either tuition calculation or payment application. To specify this, select
its Group Type:

• Tuition Calculation

If you select this type, you can group only academic period fees.

You can assign a fee group to an academic level, or you can manually assign fee groups to students. The tuition
calculation process uses fee groups to determine which fees to include in students' fee assessments. If students
aren't assigned to a group, the tuition calculation process looks at the default settings to determine which fee
group is assigned to an academic level. The process then uses the fee group assigned to the academic level to
assess students' fees.

• Payment Application

If you select this type, you can add fees of any type, be they academic period fees, miscellaneous fees, and so
on.

Fee groups of this type need to be tied to a charge priority mapping. Then the charge priority mapping needs
to be tied to a student credit. With these associations in place, the payment application process can determine
which fees can be paid off by a student credit.

If a fee group doesn't have any fees in it:

• The tuition calculation process interprets this as no fees are eligible for tuition assessment.

• The payment application process interprets this as no fees are eligible for payment by a receipt or credit.

To assign a fee group to a student, go to the Finances work area, click the Student tile, then search for the student, then
click the name. On the student's account summary page, click Actions > Manage Student Academic Periods.

To assign a fee group to an academic level, go to the Setup and Maintenance work area, and use the Manage Fee
Group Default Settings task.

• Offering: Student Management

• Functional Area: Student Structures

Note that you can assign only one fee group to an academic level per institution.
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You can override the fee group assigned to a group of students using the Fee Calculation for Multiple Students
process. To run the process, click Navigator > Tools > Scheduled Processes.

When you run this process, make sure you select values in:

• Run Option, select Override fee group.

• Calculation Required, select Yes.

• Fee Group, select the group you want to use.

• Retain Existing Fee Group, select No.

Manage Charge Priority Mapping  
A charge priority mapping lets you group individual fees or fee groups, and set distinct payment priorities for each fee
or group in the mapping. Individual fees can be curriculum fees, academic period fees, miscellaneous fees, and so on.

Fee groups, on the other hand, are a collection of individual fees. Student credits use charge priority mappings so that
the payment application process knows the priority in which payments are applied to fees.

To access the page, from Student Central search for   Charge Priority Mappings .

When you create a mapping, use Mapping Method to define the types of fees that can be included in the mapping.
Select:

• Fee to group individual fees of any type. You can group any combination of individual fees.

• All Fees to automatically include any student fees that exist in your implementation. When you go to a
student's account to apply a payment and either you set this mapping as the default or the student credit you're
using uses this type of mapping, you will be able to apply the payment to any charge in the student's account.
With this mapping method, you don't have to add any fee.

• Fee Group to create a group with only fee groups that are of the Payment Application type.

Before you can add fees to the mapping, you need to save it. If you don't add fees, the payment application process
interprets it as no fees are eligible for payment using this charge priority mapping.

When you attach a charge priority mapping to a student credit, the payment application process uses the information
in the mapping to identify which fees or charges the student credit should pay off first. So you may want to assign a
priority to each fee or group in your mapping. If you don't specify a priority, 9999 is automatically assigned, which is the
lowest priority. The higher the number, the lower its priority.

Note:  You can set a charge priority mapping as the default mapping by clicking Set as Default. When payments need
to be applied, payment application process will look for the default mapping. The payment application process uses
the information in the mapping to determine which fees to pay off first. If you don't have a default charge priority
mapping, then the payment application process applies payments to charges with the oldest due date first. If the due
dates are the same, the payment is applied based on the ascending order of the invoice number.

Related Topics
• Manage Fee Groups

• Manage Student Credits
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Export and Import Payment Application Fee Groups  
Export fee groups from one environment to another so that you don't have to manually create them.

Payment application fee groups are collections of fees that are used with a charge priority mapping. A charge priority
mapping is then associated to a student credit. This association tells the payment application process which fees in the
mapping can be paid off using a given student credit.

Remember, before you export and import fee groups, make sure that the source and target environments have the
same Oracle Cloud Applications revision.

To export and import fee groups, see Export and Import CSV File Packages. Once you have imported the fee groups, you
can check if they were properly imported in your target environment. To check, from Student Central search for   Fee
Groups .

Curriculum Costs  
Curriculum costs are associated with a course or scheduled course in the Curriculum Registry. They help your institution
evaluate the cost of delivery for its ROI calculations.

A scheduled course is also known as a course section.

You can set up curriculum cost items for an institution and calculate those costs by an amount for each enrollment,
a flat amount, or as a percentage of total fees. In addition, you can review and sort curriculum costs or duplicate an
existing one.

As an implementor, in the Setup and Maintenance work area use the Manage Curriculum Costs task:

• Offering: Student Management

• Functional Area: Student Structures

As an administrator, you can edit curriculum costs. To access the page, from the Finances work area click Actions >
Manage Curriculum Costs.

Related Topics
• Curriculum Build Statuses

Tuition Calendars  
Tuition calendars work with tuition schedules to define student payment and refund parameters. Configure tuition
adjustment calendars to define the timetable for refunds when a class is dropped. Due date calendars, along with due
date schedules, determine when you expect students to pay invoices.

The calendars you set up include:

• Adjustment calendars

• Due date calendars
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Adjustment Calendars
Adjustment calendars interact with adjustment schedules to set up refunding rules. Creating adjustment calendars
enables you to subsequently create adjustment schedules. You can review existing calendars and create new ones
based on date ranges or academic periods.

As an implementor, in the Setup and Maintenance work area use the Manage Adjustment Calendars task:

• Offering: Student Management

• Functional Area: Student Structures

As an administrator, you can edit adjustment calendars. To access the page,from the Finances work area click Actions >
Manage Adjustment Calendars.

Due Date Calendars
Due date calendars work with due date schedules to enable you to associate the correct due date with a fee. The due
dates defined here are stamped on student charges, not on adjustments. You define due date calendars by Set ID
and relate them to either an academic period or date range. A pivot date, such as the scheduled course start date,
is the starting place to calculate due dates. Oracle Fusion Cloud Student Management counts the due dates either
backward or forward from the pivot date that you select. Note that if fields on this page, such as Due Date Code, are
used elsewhere in the application, the fields appear in gray and are unavailable to edit.

A scheduled course is also known as a course section.

As an implementor, in the Setup and Maintenance work area use the Manage Due Date Calendar task:

• Offering: Student Management

• Functional Area: Student Structures

As an administrator, you can edit due date calendars. To access the page, from the Finances work area click Actions >
Manage Due Date Calendars.

Rapid Implementation of Tuition Calendars
You can create and upload calendars using the Rapid Implementation process:

• Create student tuition calendars using the Create Student Tuition Calendar in Spreadsheet task in the Setup
and Maintenance work area, Student Management offering.

• Create student due date calendars using the Create Student Due Date Calendar in Spreadsheet task in the
Setup and Maintenance work area, Student Management offering.

• Create tuition adjustment calendars using the Create Student Fees in Spreadsheet task in the Setup and
Maintenance work area, Student Management offering.

Related Topics
• Tuition Schedules

• Rapid Implementation for Oracle Student Management Cloud
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Tuition Schedules  
Tuition schedules work with tuition calendars to define student payment and refund parameters.

Configure tuition adjustment schedules to define the percentages to be refunded when a class is dropped. You also
define the default academic periods used throughout the business unit. Due date schedules, along with due date
schedules, determine when you expect students to pay invoices.

The schedules you set up include:

• Adjustment schedules

• Due date schedules

Adjustment Schedules
Adjustment schedules work with adjustment calendars; create an adjustment schedule and associate it with an
adjustment calendar to determine a refund schedule. You can review adjustment schedules, duplicate an existing one,
or create a new schedule for tuition adjustment. You can show or hide adjustment details including the date range
during which adjustments are allowed, as well as the refund percentage.

As an implementor, in the Setup and Maintenance work area use the Manage Adjustment Schedules task:

• Offering: Student Management

• Functional Area: Student Structures

As an administrator, you can manage adjustment schedules. To access the page,from the Finances work area  click
Actions > Manage Adjustment Schedules.

Due Date Schedules
Due date schedules enable you to create, review, and update the specific timing used to calculate a due date on
the charge. Due date schedules are related to the same academic period or date range as their associated due date
calendar. For any calendar Set ID you can review due date schedules, duplicate an existing one, or create a new one. You
can review due date calculation details, such as the number of days from the pivot date or system date that the charge is
due.

As an implementor, in the Setup and Maintenance work area use the Manage Due Date Schedule task:

• Offering: Student Management

• Functional Area: Student Structures

As an administrator, you can manage due date schedules. To access the page,from the Finances work area  click
Actions > Manage Due Date Schedules.

Rapid Implementation of Tuition Schedules
You can create and upload schedules using the Rapid Implementation process. Create specific adjustment schedules
using the Create Student Fees in Spreadsheet task in the Setup and Maintenance work area, Student Management
offering.
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Related Topics
• Tuition Calendars

• Student Fees

• Rapid Implementation for Oracle Student Management Cloud

Student Credits  
Credits are payments that are used to offset charges on student accounts. You can export and import credits from a
source to a target environment.

Creating and posting credits to student accounts is pivotal for institutions that award external funds. There are often
federal, state, or institutional guidelines that determine which type of fees certain types of financial aid can apply to. You
can set up credit using various combinations of charge priority mapping and credit priority. You can configure mappings
that apply credits to outstanding charges in different ways. For example, you can create a mapping that pays only a
specific charge. The calculation and posting process uses the charge priority mapping and credit priority to determine
how to apply the credit.

External Fund  
External fund credits aren't tied to a specific calculation criteria. You determine the amount that you want to post to a
student account.

For example, you could have two students who are eligible for a state scholarship. One is awarded US$250 and the other
US$1,000. You can post an external fund credit for each student and specify the exact amount of the award.

Receipt Method  
Receipt method credits are payment credits. They are a type of student payment that enables you to group various
receipt methods in the same credit. The receipt methods adhere to the same payment rules and priority that's defined
in the charge priority mapping you associate to the credit.

Here are a few scenarios illustrating the results that you might see depending on the priority you use.

• Scenario 1: You created two student credits (SC1 and SC2) with different priorities: SC1 has priority "10" and SC2
has priority "50." This means that SC1 has a higher priority than SC2. You also configured SC1 and SC2 to use
the same receipt method (RM1).

You can use any of these credits to pay off the same fee.

Now we have a student, John, and there's a charge (C1) in John's account.

When you configured SC1 and SC2, the charge priority mapping you associated with each credit lets you use
either one to pay off C1. Since both credits can be used to pay off C1, the payment application process will look
at the priority you set for each credit. In this example, SC1 has a higher priority than SC2, so the process will use
the credit SC1 to pay off C1.
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• Scenario 2: You created two student credits with the same priority. You configured them such that both credits
can be used to pay off the same fees. In this scenario, the payment application process will choose a credit
according to the alphabetic order of the credit name.

Sponsorship  
A sponsorship credit is used in a sponsorship agreement and is unique to the agreement. This means you can associate
this type of credit only once to an agreement. Sponsorship credits use specific criteria when applying payments and is
closely tied to course enrollment.

Waiver  
Waivers provide a convenient, consistent, and easily maintainable way of waiving or reducing tuition or fees. You can
configure waivers to apply to specific academic periods, curriculum, or both. Waivers or reductions can be by a flat
amount, a percentage of the fees, or an amount per unit.

Currently, waivers are applicable only to academic period fees, academic period course fees, or academic period
scheduled course fees.

Credit Setup Scenarios  
These scenarios illustrate how you could set up a credit.

Set Up a Credit for Tuition Only
Suppose you want to set up a credit that pays only tuition fees. To do so, you would create an external fund credit that
pays only tuition.

First, on the Manage Fee Groups page, create a fee group—let's call it "Tuition-Only Fee Group." To this fee group,
assign tuition charges.

Next, create a charge priority mapping using "Tuition-Only Fee Group."

After that, on the Manage Student Credits page, create the external fund credit, then select the charge priority mapping
"Tuition-Only Fee Group."

You might also want to assign a credit priority. When you use this credit and post it to a student's account, the process
follows the mapping rule and credit priority. Then the process applies the credit only to the tuition charges that are
present in the fee group.

Set Up a Credit That Applies to Any Charge
What about if you want a credit that you can apply to any charge? You would create an external fund credit that uses a
charge priority mapping that's set up to pay all charges.
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Manage Student Credits  
Credits often come from external sources, such as third-party sponsors, federal financial aid awards, scholarships,
institutional aid, state aid programs, or granted waivers. You can use these credits to pay off outstanding charges in
student accounts.

Before you start

Make sure you set up transactions properly in Oracle Fusion Cloud Financials. We strongly recommend that you consult
a core Oracle Fusion Cloud Financials consultant, implementation partner, or systems integrator to help you implement
Financials.

From the Manage Student Credits page, you can:

• Create a credit.

• Modify existing credits.

• Assign students to sponsorship credits or waivers.

• Post external fund credits or waivers to student accounts.

To access the page, from Student Central search for Student Credits. From the landing page, there are various filters,
sorting methods, and advanced search to help you narrow down the list of credits on the page.

Here's information about some fields that you fill out when creating a credit:

• Credit Code is a short name for the credit. You can enter nonalphanumeric characters.

• Source of Credit can have values that are either internal or external. Internal sources are Oracle-managed.
External sources are things like financial aid. You can update the values on this list by updating the lookup type
ORA_CREDIT_SOURCE_CODE.

• Select the  Charge Priority Mapping  you want to assign to this credit. A charge priority mapping lets you
group individual fees or fee groups and set distinct payment priorities for each fee or group in the mapping.

If you don't select a charge priority mapping, the posting process uses the default mapping for the academic
business unit.

• The default value for Credit Priority is 9999. The higher the value, the lower the priority.

The calculation process uses credit priority as well as charge priority mapping to determine how to apply credits
to charges. A credit priority becomes relevant when students have more than one available credit that can be
used to pay off the same fees.

• If you enable Refundable Credit, excess credit amounts can be refunded to the student.

• The values you assign in Transaction Type, Receivables Activity, and Memo Line become the default values
for the credit you're setting up.

External Fund Credits
We recommend mapping the credit to a transaction type, receivables activity, and memo line that best capture where
the credit should draw its balance from.
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In Credit Setup Exceptions, you can override the default values for Transaction Type, Receivables Activity, and Memo
Line for a specific academic period. You might want to do this if you want to draw credit from a specific combination of
these fields for a particular academic period.

Receipt Method Credits
If you're creating a receipt method credit, you need to associate a receipt method. Receipt method credits let you group
various receipt methods in the same credit.

Sponsorship Credits
Sponsorship credits are closely tied to course enrollment. You specify the academic period and the corresponding
curriculum that this credit applies to. You would only be able to use this credit for charges related to specific courses in
the curriculum. For more information, see Manage Sponsorship Credits.

Waivers
Currently, waivers can be applied only to academic period fees, academic period course fees, and academic period
scheduled course fees. To configure waivers, see Manage Waivers.

Manage Waivers  
Use waivers to reduce tuition or fees. Currently, waivers apply only to academic period fees. Waivers are automatically
applied when the tuition calculation process runs.

As with any student credit, the calculation and posting process uses the combination of the Charge Priority Mapping
and Credit Priority to determine how to apply the waiver.

For students to use the waiver, you need to assign them manually to the waiver. And if the waiver is set up with
academic periods, curriculum, or both, students have to be enrolled in the specified academic period, curriculum, or
both.

Note that waivers are applicable only to academic period fees, academic period course fees, and academic period
scheduled course fees.

Related Topics
• Assign Students to Waivers

Credit Setup  
In this section of the task wizard, you define the criteria that controls how the waiver is applied. For example, if you
select "Curriculum only," after you create the waiver, the Curriculum page appears. On this page, you need to add one
or more curriculum. Any student who is enrolled in this curriculum and who has been assigned to this waiver becomes
eligible for the waiver.

To set up the waiver, you can choose from among these options:

• Accept all indicates that the waiver applies to any type of academic period fee, regardless of academic year or
curriculum.

• Curriculum only indicates that the waiver applies to academic period fees only for the specified curriculum.

• Period only indicates that the waiver applies to academic period fees only for the specified academic period.
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• Curriculum or period indicates that the waiver applies to academic period fees for the specified curriculum or
academic period.

• Curriculum and period indicates that the waiver applies to academic period fees only for the specified
curriculum and academic period.

Depending on your setup, you would have to add curriculum, academic period, or both. Adding these items means that
the waiver is applicable to the academic period fees associated with the curriculum, academic period, or both. You're
also given the option to override the default calculation rules for the academic periods you add to the waiver.

The fees and fee groups associated with the waiver are derived from the charge priority mapping you selected.

Note:  To ensure you can use the waiver, activate it.

Default Calculation Rule  
For each waiver, you would also have to define how the waiver is applied to the fee:

• Flat amount indicates that a fee is reduced by the amount you specify.

• Percentage indicates that a fee is reduced by the percentage you specify, up to the indicated maximum
amount.

• Amount per unit indicates that a fee is reduced by the amount per billing unit you specify, up to the indicated
maximum amount. The waiver is applied until the date you specify in Adjust Until.

Assign Students to Waivers  
For students to use the waiver, you need to manually assign them to the waiver. And if the waiver applies to specific
academic periods, curriculum, or both, students have to be enrolled in the specified academic period, curriculum, or
both.

1. From Student Central, search for Manage Credit Assignments.
2. Click Actions > Assign Students.
3. Follow the task wizard to complete the assignment.

In the Default Calculation Rule step, you can override the default rule that's been set up for the waiver. If you don't want
to override it, just select None.

If you use an override at this level, this rule takes precedence over the calculation rules for the waiver and the specified
academic period.

Post Student Credit  
Post external fund credits to pay off outstanding charges in student accounts. Or post waivers to reduce fees or tuition.
Posting waivers is optional because the waiver is automatically applied when the tuition calculation process runs.

The Post Credit Transactions page lets you review existing external fund credits and waivers. You can use the credits to
settle or reduce outstanding charges in one or more student accounts. You'll be able to select students and academic
periods.
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For external funds, you'll indicate the amount to post to student accounts.

For waivers, the posting process uses the calculation rule you defined.

On the landing page, there's a list of credits. You can see which ones are posted or reversed. You can use various filters
to refine the list so that you're only looking at the credits you want to see.

1. To access the page, from Student Central search for Post Credit Transactions.
2. Click Actions > Post Credit.
3. Follow the task wizard to complete the action.

Once you initiate the posting process, the payment application rules take effect. The posting process looks at the charge
priority mapping as well as the credit priority to determine which charges are eligible, the order they should be paid, and
what balance is paid.

For waivers, the fees are reduced or waived based on the calculation rule. After calculation, the posting process uses the
charge priority mapping and credit priority to settle the balance. If the waiver has already been applied to a particular
student account, the process skips that account.

Results:

The posted credit should appear on the landing page. Depending on how you set up the external fund credit, it pays off
eligible outstanding charges.

Reverse Student Credit  
If you mistakenly posted a credit to a student account, you can reverse the posted amount. Only full reversals are
supported. This means that the posted credit is set to zero upon reversal.

Reversing a credit is useful in cases where an awarded amount was incorrectly posted to a student's account. By
reversing the credit, you can correct the mistake.

1. To access the page, from Student Central search for   Post Credit Transactions
2. Click Actions > Reverse Credits.

A list of posted credits appears. You will see the student's name and amount that was posted to the student
account.

3. Select one or more credits to reverse.
4. Click Reverse Credits.

Results:
The reversed credit should appear on the landing page.

Export Student Credits  
If you have a source (test) environment with student credits, you can export them to your target (production)
environment so you don't have to recreate them.

91



Oracle Fusion Cloud Student Management
Using Student Management

Chapter 10
Finances

Before you start

• Make sure that your source and target environments are on the same Oracle Cloud Applications revision level.

• It's extremely important that the values that are used in the student credits you're exporting are present in your
target (production) environment. If not, you won't be able to import the credits.

Here are examples of the fields whose values must exist in your target environment:

◦ Source of the Credit

◦ Transaction Type

◦ Memo Line

◦ Receivables Activity

◦ External Reference

◦ Academic Institution

◦ Academic Period

◦ Program Name (Curriculum Name)

Here's what to do

1. In your source (test) environment, from the Setup and Maintenance work area, go to:

◦ Offering: Student Management

◦ Functional Area: Student Structures

2. In Tasks > Show, select All Tasks.
3. Click View Columns > Actions. The Action column appears.
4. In the Manage Student Credits row, click Manage Student Credits: Actions > Export to CSV File > Create New. The

Export Setup Data to CSV File page appears.
5. To start the export process, click Submit.
6. On the Confirmation dialog box, click OK.
7. To monitor the status of the export process, click Manage Student Credits: Actions > Export to CSV File.

Depending on the status, you might see "Exporting setup data" or "Ready for download."
8. When you see Ready for download, click it. The Export Setup Data to CSV File Results page appears.
9. Click Download File, then save the file to your hard drive. This file contains the student credits that you can import in

your target environment.

Import Student Credits  
If you have student credits in a test environment, you can import them in your target (production) environment so you
don't have to recreate them.

Before you start

• Make sure that your source and target environments are on the same Oracle Cloud Applications revision level.

• It's extremely important that the values that are used in the student credits you're exporting are present in your
target (production) environment. If not, you won't be able to import the credits.

Here are examples of the fields whose values must exist in your target environment:
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◦ Source of the Credit

◦ Transaction Type

◦ Memo Line

◦ Receivables Activity

◦ External Reference

◦ Academic Institution

◦ Academic Period

◦ Program Name (Curriculum Name)

Here's what to do

1. In your target (production) environment, from the Setup and Maintenance work area, go to:

◦ Offering: Student Management

◦ Functional Area: Student Structures

2. In Tasks > Show, select All Tasks.
3. Click View Columns > Actions. The Action column appears.
4. In the Manage Student Credits row, click Manage Student Credits: Actions > Import from CSV File > Create New.

The Import Setup Data from CSV File page appears.
5. Click Choose File, then select the file you exported.
6. To start the import process, click Submit.
7. On the Confirmation dialog box, click OK.
8. To monitor the status of the import process, click Manage Student Credits: Actions > Import from CSV File.

Depending on the status, you might see "Importing setup data" or "Ready for data validation."
9. When you see Ready for data validation, click it.

On the results page appears, the status shows "Completed successfully."
10.Click Done.
11. To verify that the credits were imported, click Manage Student Credits. You should see the credits.

Sponsorship  
Sponsorship enables organizations to provide financial support to individuals. External organizations and educational
institutions set up an agreement to make this possible.

A sponsorship is made up of a sponsorship fee, a sponsorship credit, and a sponsorship agreement. The agreement
is between a third party (these are external organizations like corporations) and your educational institution. The
agreement indicates that the external organization pays all or a portion of a student's tuition and fees. The third party or
external organization determines which students are eligible for sponsorship as well as which courses are sponsored.

The bursar role maintains a sponsorship, while the administrator is likely the one who creates a sponsorship agreement.
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Note:  A sponsorship is assigned to a particular period of time. Academic reporting periods are the basis of this
timing. The due dates of fees, student credit eligibility, and assigning sponsorship all use academic reporting periods.
In setting up sponsorship fees and credits, remember that the fee and credit must use the same academic period as
the course or program to be sponsored.

To start a sponsorship, these are some things you may need to do:

• Make sure that the administrator has access to the reference data your institution uses.

• Create an external organization if one doesn't exist. This organization acts as the sponsor.
Make sure you provide an address when you create the organization. This ensures that a customer account is
generated, which then lets you create a sponsorship for the organization.
To create an external organization, you can either:

◦ Create one manually.

◦ Use the Rapid Implementation process to create many external organizations at one time.

An external organization can have multiple customer accounts associated with it because a separate customer
account is created for every sponsorship agreement. Each sponsorship agreement is treated as a separate
account to facilitate management and record keeping. This account is recorded in the agreement.

• Create a sponsorship fee.

• Create a sponsorship credit. You can assign a sponsorship credit to only one sponsorship agreement. A
sponsorship credit is unique to an agreement.

• Create your sponsorship agreement.

Enable Access to Reference Data  
To create a sponsorship, you need to have access to the reference data your institution uses.

An administrator is likely the one who creates a sponsorship agreement. You need to make sure that the administrator
has access to the reference data your institution uses.

1. In the Setup and Maintenance work area, use the Manage Data Access Set Data Access for Users task.

◦ Offering: Student Management

◦ Functional Area: Users and Security

2. Check whether the user has data access:
a. Click Users with Data Access.
b. Provide either the user name or the role, then click Search.

If your user has data access, the results show the user with the appropriate role, security context
(reference data set), and security context value.

3. If the user doesn't appear in the search results, then you must set up data access for the user:
a. Click Actions > Create.
b. In User Name, search for the user.
c. In Role, select Bursar.
d. In Security Context, select Reference data set.
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e. In Security Context Value, select the appropriate set ID (one that you're using).

You would have set up your reference data when you implemented Oracle Fusion Cloud Financials.
f. Click Save and Close.

4. Click Done.

Manage Sponsorship Credits  
A sponsorship credit is one of the items that make up a sponsorship. You need to create this credit before you can create
a sponsorship agreement.

1. To create a sponsorship credit, from Student Central search for Student Credits.
2. Click Create Credit.

Note that while the credit is created, it's not automatically active. You'll have to activate it later.
3. Fill out the required fields. Some of the fields are similar to the fields that you fill out for other types of student

credit.

Here are fields specific to a sponsorship credit:

◦ When you select Bill Sponsor,  Academic Institution is enabled.

Selecting this option automatically posts students' fees to the sponsor's account.

◦ Student Resource Information is reserved for future use.

◦ Select the Academic Institution that should be charged with the sponsorship fee.

4. Click Next. The credit is automatically saved.
5. From the Academic Period tab, click Add Academic Period to select the academic period the sponsorship

credit is applicable to.

Make sure to add the academic period that's also used in the sponsorship fee.

◦ In Transaction Type, select the type of transaction that Student Management can use to identify the fee
when it's charged for the academic period.

◦ In Receivables Activity, select the transaction distribution account that you want to use for the expense
or revenue generated by the adjustment.

6. After adding academic periods, you can add curriculum. From the Curriculum tab, select an academic period.
You can begin adding courses you want to sponsor.

a. Click Add Curriculum.
b. Follow the task wizard to add courses and complete the task.

7. Make sure you set the credit to Active so that you can use it.
8. Save your changes.

When you save a credit, a Copy button appears. This makes it easy to copy academic periods and curriculum from an
existing credit.
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Manage Sponsorship Agreements  
To create a sponsorship agreement, you need to identify the sponsoring organization and create a link between the
credit and fee. You can also specify the sponsorship amount.

Note that a sponsorship agreement is required only if you've enabled Bill Sponsor in the credit.

From the Finances work area, click Actions > Manage Sponsorship Agreements.

When you create an agreement, here's what you fill out:

• On the Basic Information page, enter information such as the name of the agreement, the external sponsoring
organization, agreement priority, and so on.

• On the Agreement Details page, make sure you use the appropriate sponsorship credit and fee. This is where
you create a link between the sponsorship credit and fee. Additionally, you can specify the maximum amount
that your agreement sponsors or specify an amount to sponsor per student.

• On the Billing Details page, enter optional information about the contract such as information the institution or
sponsor wants to appear on all bills.

Related Topics
• Manage Sponsorship Fees

Select Students and Curriculum to Sponsor  
Choose the students and curriculum that you want to sponsor. Make sure that a sponsorship credit and sponsorship
agreement exist and that you've linked the credit to the agreement.

Courses that are eligible for sponsorship are set up in the sponsorship credit. If you don't see the course that you want
to sponsor, you need to add it to the sponsorship credit. Note that a sponsorship agreement is required only if you've
enabled Bill Sponsor in the credit.

1. From Student Central, search for Manage Credit Assignments.
2. Click Actions > Assign Students.
3. Follow the task wizard to complete the assignment.

When selecting a curriculum, you can choose from these options:

◦ Select All Sponsored Curriculum. This option means that you're essentially sponsoring students for all
the curriculum associated with the academic period. The process selects all the curriculum linked to the
academic period for this specific student credit. And students can enroll in any of the listed courses.

◦ Select Any Curriculum Associated with the Academic Period. This option lets you override the
curriculum that's associated with the academic period. For example, an academic period is set up with
various courses for product management, sales, or training for specific applications. If you want to
sponsor only product management courses, then select only the product management courses. Doing so
allows students to choose only from among product management courses.
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Update a Student's Sponsorship Status  
There might be instances when students are no longer eligible for sponsorship and you need to update their
sponsorship status.

Note:  If you remove students from the sponsorship and they're already enrolled in the course, the students have to
pay the associated fees.

1. From Student Central, search for Manage Credit Assignments.
2. Click Actions, then choose an action to perform:

Action Description

Activate This action assigns the student to a sponsorship.
 
Typically, you wouldn't have to activate a student's assignment to a sponsorship. Once
you assign a student to a sponsorship credit, the sponsorship assignment is automatically
activated.
 

Inactivate This action takes a student out of the sponsorship. It means that the sponsorship status is
suspended.
 

Cancel Assignment This action removes the student from the sponsorship. All the sponsorship credits the student
received will be reversed.

Delete This action removes the student from the sponsorship assignment. Use this to remove students
that were mistakenly added to a sponsorship.
 

Billing  

Calculate Fees for Multiple Students  
Run a process that calculates fees for multiple students instead of calculating fees one student at a time.

Here are the steps:

1. Click Navigator > Tools > Scheduled Processes.
2. Click Schedule New Process.
3. Select Fee Calculation for Multiple Students and click OK.
4. Select a Population Selection query to identify your group of bill recipients and click OK.
5. Select other values such as academic period.
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6. Click Submit.

Population Selection
You can use person tags in your population selection query to identify which group of students to include when you run
the Fee Calculation for Multiple Students process. Person tags are labels assigned to students so you can easily group
them.

Use the Manage Population Selection Process Contexts task to specify a BI query folder location for queries. When
you run a process, you select a query and the process uses that location to find the query.

For the Fee Calculation for Multiple Students process, create two queries. You use the first query as a filter in the
second query.

1. A query for the Person Attributes Real Time subject area.
2. A query for the Student Accounts Real Time and Person Real Time subject areas.

When you run the Fee Calculation for Multiple Students process, you select the second query for your population
selection query.

Let's look at the steps for Query 1:

1. Click Navigator > Tools > Reports and Analytics.
2. Click Browse Catalog. Make sure your browser is set up to allow pop-ups. Oracle BI appears.
3. Click New and select Analysis.
4. Select the subject area Higher Education - Person Attributes Real Time.
5. In the Subject Areas pane, expand folders and double click columns to add them to the analysis.
6. You can filter the results:

a. In the Selected Columns area, click the button for the column and select Filter.
b. Enter the filter parameters.

7. To view the results of your query, click the Results tab.
8. Click Save Analysis.

Let's look at the steps for Query 2:

1. Click New and select Analysis.
2. Select the subject area Higher Education - Student Accounts Real Time.
3. Expand the Student Academic Period folder and double click Student Academic Period Id to add the column

to the analysis. Student Academic Period Id is a required parameter for the Fee Calculation for Multiple
Students process.

4. In the Subject Areas pane, click the Add Remove Subject areas icon.
5. Select Higher Education - Person Real Time and click OK.
6. Expand the folders and double click the columns that you want to add to the analysis.
7. You can edit a column name, to indicate, for example, which subject area it belongs to.

a. Click the button for the column and then click Column Properties.
b. In the Column Format tab, select Custom Headings.

8. Complete these steps to use the previously created Person Attributes Real Time query (Query 1) as a filter:

a. In the Selected Columns area, for the column you want to filter on, click the button for the column and
select Filter. A New Filter window opens. Let's say Party ID is a column in the Person Attributes Real
Time query. To create a filter on the current query to bring in all students whose party ID is the same as
the Person Tags query, select the Party ID column for filtering in the current query.

b. For Operator, select this value: is based on results of another analysis.
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c. For Saved Analysis, browse to find your Person Attributes Real Time query and click OK.
d. For Relationship and Use values in Column, select the values and click OK.

9. To view the results of your query, click the Results tab.
10. Click Save Analysis.

Automatic Fee Calculation  
The fee calculation process facilitates the assessment of student tuition. To ensure that the fee calculation process runs
automatically, you need to set up the academic period correctly as well as enable calculation.

To initiate fee calculation automatically, make sure that the following settings are in place:

1. Make sure that your academic reporting periods use the Auto Tuition Calculation attribute. Using this attribute
indicates when tuition calculation will run for a particular academic period.

2. Enable Calculation Required.
a. Go to the Finances work area, search for the student, then select their name.
b. On the Account Summary page, click Actions > Maintain Student Academic Periods.
c. Select Calculation Required for the relevant academic reporting period.

Sometimes you will find that you don't need to select the Calculation Required check box for the academic period.
When the following events occur, the check box is automatically selected:

• A student enrolls in, drops, or withdraws from a course.

• A student's official residency information changes.

• A student's fee group is overridden.

Results:
A student's fees are automatically calculated when these things happen:

• A student or bursar accesses the student's account.

• A student enrolls in or drops a course in self-service.

Related Topics
• Create and Manage Academic Periods

Generate Balance Forward Bills  
You can generate balance forward bills for students and organizations. To set up this feature, go to the Manage
Academic Business Unit page to specify the customer profile class and payment term enabled for Balance Forward Bills
in Account Receivables.

Here's what balance forward bills include:

• A beginning balance.

• Credits and charges since the last billing date.

• An end balance or balance due.
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To generate balance forward bills, schedule the Generate Billing Transactions process. The process generates billing
transactions for students and external organizations (sponsors) using the criteria you provide.

1. Click Navigator > Tools > Scheduled Processes.
2. Click Schedule New Process, then search for Generate Billing Transactions.
3. Click OK.
4. Select whether to generate billing for students or sponsors (external organizations).
5. Select a Population Selection query to identify your group of bill recipients and click OK.
6. Select other values. For example, you can select that you want to format bills and print them as PDF using the

Formatting Bills process.

You can select to notify a student when a bill is printed.
7. Click Submit.

Once the process is submitted, here's what happens:

a. All transactions that have posted since the last billing date, less than or equal to the due date that you
entered, are selected.

b. The information is passed to your accounts receivable system.
c. Bills are generated based on the selected bill template.

Because credits don't have due dates, the process uses the transaction date as the selection criteria instead. It includes
all credits with a transaction date less than or equal to the due date parameter since the last billing date.

The Generate Billing Transactions job stamps all processed transactions with a bill number and bill date. You can
view this information on a student's Charge Activity page, as well as on the individual invoice or charge page. For
organizations, go to each organization's account page, then select a receipt or invoice to view the corresponding bill.

Population Selection for Students
Use person tags in your population selection query to identify which group of students to include when you run the
Generate Billing Transactions process. Person tags are labels assigned to students so you can easily group them.

Use the Manage Population Selection Process Contexts task to specify a BI query folder location for queries. When
you run a process, you select a query and the process uses that location to find the query.

For the Generate Billing Transactions process, you first create two queries. You use the first query as a filter in the
second query. Then when you run the process, you select the second query for your population selection query.

1. Create a query for Person Tags Real Time subject area.
a. Click Navigator > Tools > Reports and Analytics.
b. Click Browse Catalog. Make sure your browser is set up to allow pop-ups. Oracle BI appears.
c. Click New and select Analysis.
d. Select the subject area Higher Education - Person Tags Real Time.
e. In the Subject Areas pane, expand folders and double click columns to add them to the analysis.
f. You can filter the results:

i. In the Selected Columns area, click the button for the column and select Filter.
ii. Enter the filter parameters.

g. To view the results of your query, click the Results tab.
h. Click Save Analysis.

2. Create a query for Student Accounts Real Time and Person Real Time subject areas.
a. Click New and select Analysis.
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b. Select the subject area Higher Education - Student Accounts Real Time.
c. Expand the Student Academic Period folder and double click Student Academic Period Id to add the

column to the analysis. Student Academic Period Id is a required parameter for the Generate Billing
Transactions process.

d. In the Subject Areas pane, click the Add Remove Subject areas icon.
e. Select Higher Education - Person Real Time and click OK.
f. Expand the folders and double click the columns that you want to add to the analysis.

g. You can edit a column name, to indicate, for example, which subject area it belongs to.

i. Click the button for the column and then click Column Properties.
ii. In the Column Format tab, select Custom Headings.

h. Complete these steps to use the previously created Person Tags Real Time query (Query 1) as a filter:

i. In the Selected Columns area, for the column you want to filter on, click the button for the column
and select Filter. A New Filter window opens. Let's say Party ID is a column in the Person Tags
Real Time query. To create a filter on the current query to bring in all students whose party ID is the
same as the Person Tags query, select the Party ID column for filtering in the current query.

ii. For Operator, select this value: is based on results of another analysis.
iii. For Saved Analysis, browse to find your Person Tags Real Time query and click OK.
iv. For Relationship and Use values in Column, select the values and click OK.

i. To view the results of your query, click the Results tab.
j. Click Save Analysis.

Population Selection for Organizations (Sponsors)
You need to create a population selection query to identify the organization for whom you're generating a bill. You will
use this query when you run the Generate Billing Transactions process.

1. Click Navigator > Tools > Reports and Analytics.
2. Click Browse Catalog. Make sure your browser is set up to allow pop-ups. Oracle BI appears.
3. Click New, then select Analysis.
4. Select the subject area Higher Education - Sponsor Agreement Real Timei, then click Continue.

Search for Higher Education to narrow down the list of subject areas.
5. In Select Columns, expand the subject area folders, then add columns to the analysis. For example, in Student,

you can add Name and Last Name; in Agreement, you can add Agreement Name, and so on.

Note:  Make sure you add the External Organization - Party ID column to the analysis.

6. Click Next.
7. In Select Views, click Table, then select Table (recommended).
8. Click Submit.
9. In Analysis Name, enter a name for the query, then save the query in Shared Folders > Custom > Higher

Education.
10. Click Submit.

Related Topics
• Manage Academic Business Unit

• Population Selection

• Population Selection Contexts
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Print Balance Forward Bills  
Print balance forward bills in PDF so you can verify billed transactions and answer students' billing questions.

Before you print bills, you need to do these steps:

1. Run the Generate Billing Transactions process (refer to the Generate Balance Forward Bills topic).
2. Run the Formatting Bills process to prepare bills in a specified format using particular criteria.

Here's how you run the Formatting Bills process:

1. Click Navigator > Tools > Scheduled Processes.
2. Click Schedule New Process.
3. Select Formatting Bills and click OK.
4. Select your parameters. You can use either the process ID and bill number or both.
5. Click Submit.

When a bill is included in the Formatting Bills process, a link appears for the bill in the Bill Number column on these
pages:

• Charge Activity

• View Charge

• Payment Activity

• View Payment

Click the link to view, download, or print the bill.

Payments  

Set Up Manual Payment Collection  
Some individuals might want to pay for programs or courses in person or over the phone. You need to set up manual
payment collection to support it.

1. To set this up, from Student Central search for   Academic Business Unit .
2. Click Payments.
3. In Manual Payments, click Allow manual payment collection.
4. In Default Receipt Method, select Cash.
5. In Checkout Message, enter the message you want to display to students when they make payments in self-

service. You must provide a message when you enable manual payment collection. This message should tell
students how to make payments offline.

When students see the instructions, they have the option to send the instructions to their email address.
6. Save your changes.
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Collect Payments Manually  
Once you enable manual payment collection, you can start accepting payments made over the phone or in person.

1. In the Finances work area, search for the student, then select that student's account.
2. From the student's account summary page, click Actions > Review Student Cart Items.
3. On the Review Cart page, click Continue.
4. On the Select Your Payment Method page, select Collect Payment Manually.
5. When you have collected the payment, click Confirm Payment. This generates a receipt.

The transaction is posted to the student's account and the student is enrolled.

Settle Credit Card Payments in Oracle Fusion Financials  
If you use CyberSource as your payment service provider, you need to remit the receipt and then transmit the
settlement to settle the payment.

When individuals make a payment with a credit card, CyberSource only authorizes the payment. The actual settlement
of credit card payments happens in Oracle Fusion Cloud Receivables.

For information on how to remit the receipt and transmit the settlement, refer to Oracle Financials. From Top Tasks, click
Implement, then under Implement Funds Capture, click Learn about payment gateway integration and credit card
processing . In the document, refer to these sections:

• Remit Receipt

• Submit Offline Transactions

Create Notifications About Payment Issues  
When applicants submit their application and make a payment but invoices or receipts can't be created, this may
prevent financial transactions from being posted to the applicant’s account. You need to communicate these events to
the applicant and the administrator.

Before you begin, make sure you designate an administrator who's tasked with resolving payment issues.

1. To access the page,from Student Central search for   Academic Business Unit
2. Click Payments.
3. In Payment Error Resolution, assign an administrator.

If transactions can't be posted to an applicant's account, you should notify administrators and applicants.
Administrators would have to resolve the issue, and applicants need to know whether they need to take action.

Create a Category for the Event
Before you create your notification, you must first create a category for the event. You need this category when you
create the contents of your notification.
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You can group all student financials-related events in one category.

1. To access the page,from Student Central search for   Student Management Categories .
2. Click Create Category.
3. Fill out the required fields.
4. Click Add Event.
5. Search for these events, select each one, and then click Select to add to the category you're creating.

◦ Invoice Creation Failed

◦ Receipt Creation Failed

◦ Receipt Creation Failed

6. Click the switch to change the status to active, then save your changes.

Create a Notification Template
Now, create the notification template for each event. In this example, let's create a notification for the Invoice Creation
Failed event.

1. Click Create Communication.
2. Select Event-based.
3. Fill out the required fields.
4. In Institution, select your institution.
5. In Category, select the category you created earlier.
6. In Select Event Type, select the event that this notification is for. It can be any of these:

◦ Invoice Creation Failed

◦ Receipt Creation Failed

◦ Invoice or Receipt Creation Failed

7. In Time of Day Sent, select Send communication immediately when triggered.
8. Click the Content tab. Here's where you specify the contents of the email that is sent to the administrator or

student.
9. Click Active to activate the notification, then save your changes.

Here's a list of tokens you might want to use.

Token Description

{ADDITIONAL_INFORMATION} Additional information for the transaction.

{AMOUNT} The amount collected from the source of the transaction.

{CURRENCY} The currency in which the fee is charged.

{MASKED_ORDER_ID} The masked unique identifier of the payment order.

{MASKED_STUDENT_PARTY_ID} The masked unique identifier of the student.

{RECEIPT_ID} The unique identifier of the receipt.

{SOURCE_OBJECT_ID} The unique identifier of the source of the transaction. For example, this can be a reference ID or
application ID.

{SOURCE_OBJECT_NAME} The source of the transaction. Example of sources can be application submission, transcript request,
 and so on.
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Token Description

{STUDENT_NAME} The first name and last name of the student.

{TRANSACTION_DATE} The date that the transaction was initiated.

Note:  When you create a notification for the Receipt Creation Failed event, it's important that you include the
ORDER_ID token in the email notification. The ORDER_ID tells administrators and students which record needs to be
reconciled. Also include ADDITIONAL_INFORMATION to ensure the administrator receives the steps to fix the issue.

Related Topics
• Overview of Communications

Integrate with TouchNet  
Configure Oracle Fusion Cloud Financials to integrate with TouchNet. This lets you use TouchNet as a payment service
provider.

When you configure Financials to use TouchNet, it enables your institution to use TouchNet as a payment service
provider for credit card payments.

To configure Financials, you need to:

• Learn about payment gateway integration and credit card processing.

• Configure formats to integrate with your preferred payment gateway.

For information about these processes, go to Oracle Financials. From Top Tasks, click Implement, then refer to the
documents under Implement Funds Capture.

Manage Refunds  
Use the Manage Refunds page to refund multiple recipients. You can also view a list of the refund requests you have
initiated in the past, present, and scheduled for the future.

You need to make sure these elements are set up:

• In Oracle Fusion Cloud Payables, set up payment methods.

• On the Academic Business Unit page, set up refund methods. This ensures that as you're issuing refunds, the
list of refund methods you can choose from are ones that are relevant to the business unit.

• In Oracle Fusion Cloud Receivables, set up approval limits for every individual who will issue refunds. If the
refund request fails, this may be one of the causes. The approval limits dictate which transactions an individual
can approve.

We strongly recommend that you consult a core Oracle Fusion Cloud Financials consultant, implementation partner, or
systems integrator to help you implement Financials.
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To access the page, from Student Central search for   Manage Refunds .

The landing page is the View Refunds page. There's also a Refund Processes page where you can see a list of the batch
refund processes that were initiated in the past, those that are scheduled for the future, or ones that are currently
running. You can also see which processes didn't succeed.

On the View Refunds page, you can see a list of refund payment requests for individuals and organizations. Filter and
sort the list so you're only looking at the records that you want, the way you want. You can also search for a specific
record.

When you click a refund number, you can see more information about the refund request for a recipient. The following
tabs provide various information about the refund.

Details
This page shows information about the refund and the request process that a particular refund number was a part of.
So you can see information like the process ID, the date and time the request was run, the receipt that was refunded,
and so on.

If the process ran successfully, you will see an invoice number. The invoice number corresponds to the payment request
invoice number in Receivables.

But if the process wasn't able to create a payment request invoice for the recipient, you can click Retry to run the refund
request process again.

Transaction
This page lists the receipt and relevant invoices that were included in the refund amount calculation.

Refund Payments
This page shows information like the refund payment method. If you use Oracle Fusion Cloud Payables to disburse the
refund, you can also see accounts payable information. For example, for refunds done by electronic transfer, you will see
the bank account number, payment number, the invoices that were paid, payment status, and so on.

For information about payment statuses in Payables, see Payment Actions, Types, and Statuses.

Issue Refunds for Multiple Recipients  
From the Manage Refunds page, you can immediately run a refund request for individuals or organizations. Or you can
schedule the request for a later time.

You need to make sure these elements are set up:

• In Oracle Fusion Cloud Payables, set up payment methods.

• On the Academic Business Unit page, set up refund methods. This ensures that as you're issuing refunds, the
list of refund methods you can choose from are ones that are relevant to the business unit.

• In Oracle Fusion Cloud Receivables, set up approval limits for every individual who will issue refunds. If the
refund request fails, this may be one of the causes. The approval limits dictate which transactions an individual
can approve.

We strongly recommend that you consult a core Oracle Fusion Cloud Financials consultant, implementation partner, or
systems integrator to help you implement Financials.
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To start a refund request, from the Manage Refunds page, click Issue Refunds. Take note of these fields:

• Refund Payment Method

Select whether to refund payment via check, electronic transfer (bank account), or credit card based on the
refund setup at the academic business unit level.

The refund process filters the relevant records based on the refund method you select. For example, if you
select Credit Card, the refund process selects only credit card receipts that need to be refunded. Or if you're
running the process for students and you select Electronic Transfer, the process selects students who need
refunds and have provided bank accounts.

If, for example, you run a refund request for Check, the process will skip students that provided bank accounts.
Because checks are typically costly to produce, the process goes by the best practice that you would refund
payments through checks only when absolutely necessary. And so, if students provided bank accounts, you
wouldn't be issuing check refunds to them.

• Submission Date and Time

You can run the process immediately or set it to run at a scheduled date and time.

• Refund Debit Balances

You can enable this option only if you enabled Allow Refunds with Debit Balance for the refund method at the
academic business unit level.

If you enable this, it means the process will refund the full unapplied amount of the credit for accounts that
have both unpaid charges and unapplied credits.

• Include Failed Refunds

Enable this if you want the process to evaluate unapplied credits associated with a previous failed refund.

To honor students' refund preferences, you can run an electronic transfer refund (this will get students who provided
bank accounts), and another one for check refunds (for those who prefer to receive their refund payments by check).
The relevant recipient population is selected depending on the refund method you use.

Results:

When the process succeeds, payment request invoices are created in Receivables. You still have to make the actual
payments using Payables or the payment solution you're already using.

Related Topics
• How Disbursements Are Processed

Issue Refunds Individually  
Issue refunds for each student or sponsoring organization in real time. Instead of running the refund process for groups
of students or organizations, you can create and disburse refunds for each recipient in real time. You can either issue
refund for a single receipt or for multiple receipts at a time.
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You need to make sure these elements are set up:

• In Oracle Fusion Cloud Payables, set up payment methods.

• On the Academic Business Unit page, set up refund methods. This ensures that as you're issuing refunds, the
list of refund methods you can choose from are ones that are relevant to the business unit.

• In Oracle Fusion Cloud Receivables, set up approval limits for every individual who will issue refunds. If the
refund request fails, this may be one of the causes. The approval limits dictate which transactions an individual
can approve.

We strongly recommend that you consult a core Oracle Fusion Cloud Financials consultant, implementation partner, or
systems integrator to help you implement Financials.

No additional setup is required to refund credit card payments back to the original card. To create a check or to refund
directly to a bank account, you need to make sure these elements are set up:

• In Oracle Fusion Cloud Payables, set up payment methods.

• On the Academic Business Unit page, set up refund methods. This ensures that as you're issuing refunds, the
list of refund methods you can choose from are ones that are relevant to the business unit.

• In Oracle Fusion Cloud Receivables, set up approval limits for every individual who will issue refunds. If the
refund request fails, this may be one of the causes. The approval limits dictate which transactions an individual
can approve.

Oracle strongly recommends that you consult a core Oracle Fusion Cloud Financials consultant, implementation
partner, or systems integrator to help you implement Financials.

Issue Refunds to Students or Organizations
You can refund individual receipts or refund multiple receipts for a student or an organization at once. Each receipt
always creates one refund transaction, regardless of where the receipt is refunded. If you’re using Oracle Payables, you
can combine multiple refund invoices into a single payment.

The receipts that you’re refunding must have an unapplied amount and a Remitted or Cleared status.

1. Navigate to the Finances work area.
2. Click the Student or the Organization tile, search for the student or organization, then click the name.
3. If you want to refund a specific receipt:

a. From the student's or organization's account summary, click Actions > Manage Receipts.
b. Select the receipt you want to refund.
c. Click the receipt number, then from the receipt details page, click Actions > Issue Refund.

4. If you want to refund all unapplied receipts, from the student's or organization's account summary, click
Actions > Issue Refund.

5. In the Issue Refund dialog box:
a. In the Refund Date field, select the date when you want to process the refund.

Note:  If you select the current date as the refund date, the process is submitted immediately. If you
select a future date, the process is submitted just after midnight on the specified date.

b. From the Refund Payment Method list, select the method for payment refund.

You can either honor the student's or organization's refund preference, or select a different refund
method. If you select a different refund method, you're overriding the student's or organization's
preference.
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Note:  The payment methods that you can select are pulled from the refund methods that were set up at
the academic business unit level. If you're funding a non-credit card payment, you wouldn't see a credit card
refund method. These payments can't be refunded via credit card.

You can honor the student's or organization's refund preference if you want.

1. Go to the student's or organization's account summary page.
2. Click Actions > Manage Refund Preferences.

If the student or organization has more than one refund method, you can go by the order of priority that they
indicated.

The refund process starts immediately if you’ve selected the current date or runs after midnight on the selected future
date. If a refund doesn’t succeed, it appears on the Manage Refunds page.

Manage Refund Preferences  
Indicate how you want to receive your refunds. You can set more than one preferred refund method. Administrators or
bursars can also add or update refund preferences on your behalf.

If you want to receive your refund payment through a specific account, then you need to set up your preference.

If you're a student and you're setting up your refund preferences for the first time, just go to your self-service Finances
page, then click Set Up Refund Preferences.

On the Manage Refund Preferences page, click Create Refund Payment Method. You can set up more than one refund
payment preference. If you have more than one, you can also define the priority in which you want them used. To do so,
click the Actions icon of the corresponding refund method to access the context menu. From this menu, you can select:

• Move to Bottom or Move Down to move the method down or to the bottom of the list, giving it a lower
priority.

• Move to Top or Move Up to move the method up or to the beginning of the list, giving it a higher priority.

• View Details to view information about the refund method.

• Remove to remove the refund method.

For example, you set up two refund payment preferences: a bank account and a check, and you set your bank account
as the first priority where you want your refund payments to go. But if, for example, something happens to that bank
account and the payment can't be deposited, then the institution will automatically send your refund payment to your
next preferred way to receive your refund.

You can add, update, or delete your refund payment preferences any time you need to. Just go to your self-service
Finances page, then click Manage Refund Preferences.

If you're an administrator and you need to create or update a student's preferences, then go to the Finances work area,
then search for the student. Click the student's name to access the account, then from the student's account summary,
click Actions > Manage Refund Preferences.
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Migrate Refunds from Oracle Fusion Cloud Receivables  
If you migrate refund records created in Receivables, you won't have to switch between Receivables and Student
Management to look for information about refunds.

Migrating your refund records from Receivables to Student Management makes it easier to manage refunds. You can
stay in the same environment to continue refunding or carrying out other transactions.

1. Go to Navigator > Tools > Scheduled Processes.
2. Click Schedule New Process, then search for Migrate Refunds to Student Management. You can choose to run the

process immediately or schedule it.

Start Date is an optional field. If you don't specify a date, the process will get all refunds from Receivables up to the
current date.

Integrate a Third-Party Payment Service Provider  
Use your preferred payment service provider to collect payments from students.

To integrate your payment service with Oracle Fusion Cloud Student Management, these are the things you need to do:

• Configure the payment method.

• Register your payment service provider in Student Management.

• Set up the URL to your payment page.

Additionally, you need these REST resources:

• HED Payments. With this resource, you can retrieve information about the student's fees.

• Transaction Reference Contexts. Using this resource, you can send information back to Student Management
so that it can keep records of the payment, generate the invoices and receipts, and enroll the student in the
applicable program or course.

When users make a payment in self-service, they will see Additional Services instead of Finances. Clicking on
Additional Services takes users to your external payment page. The same is true when users pay their application fees;
they're redirected to your external page if you configured external payment.

Note:  Institutions are responsible for maintaining their external payment page as well as integrating with their
payment service provider.

Configure the Payment Method  
Before you can use your own payment service provider to collect payments, you need to configure the payment method
on the Academic Business Unit page.

1. To access the page, from Student Central search for   Academic Business Unit .
2. Click Payments.
3. In Electronic Payments, select Other payment service provider.
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4. In Other Service Provider Receipt Method, select Cash, for example.
5. Save your changes.

Register Your Payment Service Provider  
After you configure the payment method, you need to register your payment service provider.

A payment service provider is essentially an external application. When you register a payment service provider, you're
given an API key. Use this key with HED Payments (REST service) to retrieve and send information about student fees.

Note:  Make sure you review the REST service definition in the REST API guides, available from the Oracle Help
Center > your apps service area of interest > REST API. If you're new to Oracle's REST services you may want to
begin with the Quick Start section.

To register your payment service provider:

1. Go to the Finances work area, then click Actions > Manage Third-Party Application Access.
2. Click Create Application. The Application field becomes available.
3. In Application, enter a name for your payment service provider, then click Save.

The API key is generated.

Set Up the URL to Your Payment Page  
To redirect users to your own payment page, you need to provide the URL to that page.

Before you begin, make sure you already configured the payment method and registered your payment service
provider.

1. Go to the Finances work area, then click Actions > Manage Custom Navigation.
2. In Navigation URL, enter the address to your payment page. When students make a payment, they're

automatically redirected to this address.
3. Save your changes.

Manage Student Accounts  
On the Account Summary page you can view students' outstanding charges, payments they've made, unused credit,
and so on. From this page, you can create curriculum and miscellaneous charges, manage receipts, and also maintain
student academic periods.

To access the summary of students' accounts, from the Finances work area, click the Student tile, search for the
student, then click the name. From the student's account page, if you click Actions, you can perform these activities:

• Create Curriculum Charge

• Create Miscellaneous Charge

• Create Receipt

• Manage Receipts
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• Maintain Student Academic Periods

Sort student transactions so you have a view of the items you want to see, whether it's all transactions, only charges, or
only payments.

You might see an Apply Payments button when you access a student's account. This button appears only if there's any
unused credit and outstanding charge in the student's account.

Whether you create a receipt (payment) or click Apply Payments, here's what can happen:

• If the receipt method is linked to an active student credit that uses a charge priority mapping, then the payment
application process looks at the receipt methods you set up in Manage Student Credits to determine if there's
an active student credit that it can use. If there's an active student credit linked to the receipt method, the
payment application process checks if there's an associated charge priority mapping, and then checks which
fees are linked to the mapping. If the fee that needs paying is included in the mapping, the process applies the
payment. The process uses the priority that's indicated in the mapping to determine the order in which fees
should be paid.

• If the receipt method is linked to an active student credit but the credit doesn't use a charge priority mapping,
then the payment process looks for the default mapping. If a default mapping exists and the fee is part of the
mapping, the process applies the payment based on the priority in the mapping. But if the fee isn't part of the
mapping, the payment isn't applied.

It can also happen that a receipt is linked to multiple student credits or to an inactive student credit. If none
of the student credits use a charge priority mapping and there's no default charge priority mapping, then the
payment application process looks for the oldest available receipt method and applies the payment.

• If you didn't set up any charge priority mapping, payment is applied based on the due dates of charges. If the
due dates are the same, the payment process looks at the invoice number to determine which charge to pay off
first.

Here are some things to take note of:

• When you want to use student credits to pay off charges, ensure that the student credit is active so that you can
use the receipt method associated with it.

• If you don't create student credits, the payment application process uses the default charge priority mapping as
the basis for identifying which charges to pay off first.

• If you don't have a default charge priority mapping, the payment application process applies payments to
charges with the oldest due date first. If the due dates are the same, the payment is applied based on the
ascending order of the invoice number.

• If the Apply Payments button doesn't appear to be doing anything, a rule may be preventing the payment from
being applied. To determine if a payment can be applied to a charge, the payment application process looks at
the receipt method to see if there's a corresponding active student credit.

◦ If the credit exists, the process looks up the associated charge priority mapping. If the charge or fee isn't
found in the mapping, then the payment isn't applied.

◦ If the credit doesn't exist, the process looks for a default charge priority mapping. If there's one, but the
charge isn't listed in the mapping, then the payment isn't applied.

If this scenario occurs, then you need to make sure that you set up your fee groups as well as your charge
priority mapping in a way that accounts for the combination of various fees that you want a student credit to
pay off.
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Related Topics
• Manage Charge Priority Mapping

• Manage Refunds

• Manage Student Credits

Create Student Receipts  
Create a receipt to settle a student charge.

To access the page, from the Finances work area click the Student tile, search for the student, then click the name. From
the student's account page, click Actions > Create Receipt.

When you create a receipt, you're essentially paying off a charge or fee. This activity calls the payment application
process.

First, you need to set up these items:

• Payment application fee groups.

• One or more charge priority mappings. You may have already set a charge priority mapping as the default.

• One or more student credits that use charge priority mappings. These credits must also be active.

Then, when you create a receipt, here are some things to note:

• In Receipt Method, the values you see are limited to the ones you set up for the academic business unit as well
as the student credits you have created. Student receipt credits are treated as receipt methods.

When you select a receipt method, the list of eligible charges you see are based on the charge priority rules
associated with the receipt method you selected. You may see different charges depending on the receipt
method you use.

The payment application process will automatically populate the amounts for each charge based on the
charge priority mapping configuration. If you update an amount that was automatically assigned, the payment
application process automatically recalculates the other amounts.

• Override Charge Priority isn't selected by default. When selected, you will be able to add other charges that
weren't a part of the original list of eligible charges.

This option gives you the flexibility to apply payments to other charges regardless of the charge priority
mapping that's linked to the receipt.

• If you want to specify a lump sum, you can enter that value in Amount. The payment application process will
then determine the amounts to apply to outstanding charges. The amounts are based on the charge priority
rules of the receipt method.

• You can also enter specific amounts for each charge in Pay Amount.

Manage Student Receipts  
Use the Manage Receipts page to view all payments or available disbursements in a student's account.

To access the page, from the Finances work area click the Student tile, search for the student, then click the name. From
the student's account page, click Actions > Manage Receipts. You can also create a receipt from this page.
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Here are some fields you see on the page.

• Receipt Number. When you click this, you see receipt details.

◦ Override Charge Priority. If you select this, you can add other charges to the receipt that you wouldn't
have been able to include if the charge priority mapping was strictly followed. You would then be able to
use this receipt to settle the charge.

◦ Transaction Number refers to the transaction number of the fee or charge.

◦ Due Date refers to the date when the fee is due.

◦ Applied Amount refers to the amount that may be equal to the amount due or just a fraction of the
amount due. This depends on how much the student is paying off at the time.

• Receipt Date refers to the date when the receipt was created.

• Receipt Amount refers to the amount available for disbursement or application to outstanding fees.

• Unapplied Amount refers to the remaining amount that's still available for disbursement.

• Receipt Method refers to the method in which the payment is disbursed.

• Status indicates the payment status.

◦ APPROVED: This status is only valid for automatic receipts, and indicates that the receipt was approved
for automatic creation. These record types are never postable.

◦ CONFIRMED: This status is only valid for automatic receipts, and indicates that the receipt was confirmed
by the customer.

◦ REMITTED: This status is valid for both manual and automatic receipts, and indicates that the receipt was
remitted.

◦ CLEARED: This status is valid for both manual and automatic receipts, and indicates that the receipt was
cleared.

◦ REVERSED: This status is valid for both manual and automatic receipts, and indicates that the receipt was
reversed.

These are the situations in which receipts can be reversed:

◦ When a user stops payment on a receipt.

◦ If the payment is from an account with insufficient funds.

◦ If you want to re-enter the payment and then reapply it in Oracle Fusion Cloud Receivables.

Related Topics
• Receivables Tables

Manage Organization Transactions  
Manually create one-off charges, issue receipts, or issue refunds for sponsoring organizations.

To access an organization's account, from the Finances work area click the Organizations tile. Search for the
organization, then click its name. From the organization's account details page, use the Actions menu to do any one
these things:

• Create a charge, that is, create a one-time charge.
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• Create a receipt. You can issue a receipt for payments made.

• Manage receipts. These are other actions you can do:

◦ View all receipts.

◦ Issue refunds individually. You can also process refunds for multiple recipients.

◦ Reverse a receipt, essentially reversing a payment.

Self-Service: View and Pay Bills  
When you're in self-service, the My Account page lets you view charges that are due. If you're in a managed student
group, you see the list of payables for each member of the group. You can also pay your bills or those of your managed
student groups.

When paying, the payment methods you can use depend on what the administrator set up. You can select any one of
these options to indicate the amount you're paying:

• Bill Amount to pay your current billed amount. If there is an amount that's due, the payment is applied to the
oldest charge and not to specific charges in the current bill.

• Total Balance to pay the sum of all your charges.

• Other to specify an amount greater than zero.

These options may vary slightly if you're in a managed student group.

In History, here's what you see.

Transactions
The table here shows you payments you have made that were processed through Oracle Fusion Cloud Financials.

Users in a managed student group might see various elements. As group manager, you see the payments you made
for the students in your group. If you're a student, you see the payments made on your behalf. You might also see icons
on each row. Clicking the icon tells you who made the payment on your behalf or for whom you paid. You can also see
another user's transaction history, bills, or transaction references. To do this, select their name from the For list.

Bills
Here you see a list of your statements of charges.

Transaction References
On this page you see a list of your transactions that were processed through your institution's own payment service
provider.

These are some of the fields on this page:

• Transaction Reference is a unique code that Student Management generates when students initiate payment.
This is the code your institution uses to retrieve details about the transaction.

• Pay Point is the area in Student Management where the fees are pulled from. This can be the shopping cart,
Finances in self-service, or the application submission page.
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• Status shows the status of the transaction reference code, for example, "Successful."

Your institution can process payments only for active transaction reference codes.

• Payment Reference is the reference code your institution's payment service provider generates when a
payment is successfully processed. Using HED Payments REST service, your institution sends this payment
reference code to Student Management, which is then displayed here.

Related Topics
• Overview of Finances

• Integrate a Third-Party Payment Service Provider

• Create Managed Student Groups
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